
CHAPTER 1-A REVIEW OF STANDARD MACINTOSH OPERATIONS

The Apple Macintosh computer is designed for ease of use and learning. It
presents you with a simulated desktop on your screen, where you can see and
manipulate icons -- graphic depictions of documents, disks, file folders, and
the other parts of your system and the information you work with. 

You use about two dozen simple operations to work with your Macintosh, and
these operations are the same regardless of the program you're using or the
task you're performing.

This chapter reviews the standard Macintosh operations and provides brief,
illustrated instructions for performing each one. If you are new to the
Macintosh, you will probably want to use the Macintosh Basics disk and the
tutorial book, Learning Macintosh (or other training materials that came with
your computer), before reading this chapter. If you are familiar with the
Macintosh, you can use this chapter for review.

Using the mouse

You use the mouse -- a kind of pointing device -- to begin most operations on
the Macintosh. When you move the mouse on your desk, a corresponding pointer,
makes the same movement on the screen.

The pointer is not always an arrow -- it often takes a different form, such
as an I-beam for editing text or a crosshair for selecting graphics. 

Pointing.  Pointing is simply moving the pointer onto an object or area on
the screen.

1.  To point, first grasp the mouse and slide it across the table top, as you
watch the pointer on the screen.

The pointer moves in the same direction in which you move the mouse.

2.  Continue moving the mouse until the tip of the pointer is on the item you
want.

If you run out of room on your desk, you can pick up the mouse and place it
at another spot. The pointer on the screen will not move while the mouse is
off the table top.

Clicking.  Clicking begins an action at the pointer's location.

1.  To click, first point to an object on the screen by moving the mouse.

2.|  Without moving the mouse, quickly press and release the mouse button
with your index finger.

Double-clicking.  Double-clicking is usually a way to display the contents of
an icon or document or to start an application program.

1.  To double-click, first point to an object on the screen by moving the
mouse.

2.  Without moving the mouse, press and release the mouse button twice in
rapid succession.



Shift-clicking.  Shift-clicking is a variation of clicking you use to select
multiple icons or other objects that are not near each other or to select
only some of the items in a group.

1.  To Shift-click, first press the Shift key on the keyboard.

2.  While holding down the Shift key, click each object that you want to
select.

Each object becomes highlighted when you click it; that is, it changes color.

Dragging.  Dragging allows you to move an item on the screen as you move the
mouse. You also drag to move an icon or a window and to select a group of
icons.

1.  To drag an icon, first point to the icon you want to move and press and
hold the mouse button.

The object becomes highlighted when you press the mouse button.

2.  Move the mouse while continuing to hold down the button.

An outline of the icon moves with the pointer, indicating the location of the
icon as you drag.

3.  Release the mouse button when the pointer is where you want the icon to
be.

The object remains highlighted when you release the button.

Working with the Finder

You use a program called the Finder to work with the icons and windows
displayed on your Macintosh desktop. The Finder is part of system software;
it starts automatically when you turn on the computer, and it is always open.

You can think of the Finder as your information manager: You use it to open
windows, start application programs, copy files, and see the contents of your
disks and folders. You're using the Finder whenever you work with an icon on
your desktop (such as when you move or open a disk icon) or use a window that
displays the contents of a disk or a folder.

A window that shows the contents of a disk or a folder is called a Finder
window.

Most icons can be opened into windows -- either a Finder window or a window
created by an application program. You can have more than one window open at
a time. But only one window can be active at a time. An active window is on
top of all other windows on the desktop. It's the window you're working in.

You can move windows, change their size, and select the window in which you
want to work. 

Selecting an icon.  Selecting means choosing an object to act upon. When
working with the Finder, you click an icon or other object to select it. When
selected, the object appears highlighted (its color changes).

1.  To select an icon, first point to the icon you want to select.



2.  Click the icon.

When you press the mouse button, the icon becomes highlighted to show that it
is selected.

See also: "Changing the Highlight Color" in Chapter 7

Summary:  Selecing icons on the desktop or in a Finder window.

Ways to select items on the desktop or in a Finder window

Task                                Instruction
Example

Selecting a single          1. Place the pointer on the icon
icon.                       2. Click.

Deselecting an icon         1. Place the pointer anywhere
except on the selected icon.

2. Click.

Selecting multiple          1. While holding down the 
icons (one at a time)          Shift key, place the pointer on each icon.

2. Click each icon (one at a time).

Deselecting one icon        1. While holding down the 
in a group of                  Shift key, place the pointer on 
selected icons                 the icon to be deselected.

2. Click the icon.

Selecting multiple          1. Place the pointer at one 
icons that are near            corner of the group of icons.
each other                  2. Drag diagonally until the icons are selected.

Selecting contiguous        1. Place the pointer at the top or 
icons in a list                bottom of the list.

2. Drag up or down the list until the icons are
selected.

Selecting text in          1. Click the icon's name to select it.
an icon's name             2. Place the pointer at one end of the text to be

selected.
3. Drag until the text is selected.

See also: "Selecting Part of the Text in an Icon's Name" later in this
chapter

Opening an icon.  The quickest way to open an icon is to double-click it.

Double-click the icon to open it.

When you double-click the icon, the icon becomes highlighted and then opens.

Another way to open an icon: You can also open an icon by selecting it and
choosing the Open command from the File menu or using the keyboard shortcut
Command-O or Command-Down Arrow.

Moving an icon.  You move an icon by dragging it.



Drag the icon to move it.

An outline of the icon moves with the pointer as you drag. When you release
the mouse button, the icon appears at the new location.

Discarding an icon.  You can remove an icon from the desktop or from a Finder
window by dragging it to the Trash, usually located at the bottom-right
corner of the desktop. To erase the contents of the icon from your disk, you
choose the Empty Trash command from the Special menu.

1.  To remove an icon, first drag the icon to the Trash so that the Trash
icon is highlighted.

The pointer and an outline of the icon move as you drag; the Trash icon
becomes highlighted when the tip of the pointer reaches it.

2.  Release the mouse buttonwhen the Trash icon is highlighted.

When you release the button, the Trash icon bulges to show that something is
inside it. The Trash icon is then no longer highlighted.

If you decide you want the item back, simply open the Trash as you would any
other icon, and drag the icon out of the Trash.

3.  To erase the contents of the Trash, choose Empty Trash from the Special
menu.

A warning message may appear. Click the OK button to continue, or click the
Cancel button to stop the Trash from being emptied. Once you empty the Trash,
the discarded icon and its contents are gone.

You can turn off the warning message if you want. The system won't let you
discard a locked document or an item that's currently in use.

Another use for the Trash icon:  You can eject a floppy disk from a disk
drive by dragging the disk icon to the Trash. This does not erase the disk.

See also: "Ejecting a Disk From the Desktop" in Chapter 6"Turning the Trash
Warning On or Off" in Chapter 7"Disconnecting From a Shared Disk" in Chapter
3 of the Macintosh Networking Reference

Viewing the contents of a window

You can see a window's contents in two ways -- by adjusting the size of the
window or by scrolling to make a different part of the window visible. You
have to scroll to see the contents of documents that are longer or wider than
the screen.

"Displaying a List of Items by Name, Size, Label, Kind, or Date" in Chapter 5
"Changing to a Different List View" in Chapter 5

Making an open window active.  You make an open window active by clicking
inside it. (You may have to move or resize other windows if the one you want
is open but covered by other windows.)

To make a window active, click anywhere in that window.

When you click, the window moves in front of other items displayed on the



screen.

Another way to make a window active:  You can make an open folder or disk
window active by double-clicking its dimmed icon.

Summary:  Moving a window and changing its size.

Ways to move a window and change its size

Task                                    Instruction
Example

Moving a window               1. Place the pointer in the window's
title bar (at the top of the window).

2. Drag the window to a new location.
(An outline of the window follows the
pointer.)

Resizing a window             1. Place the pointer in the size box (in the
window's lower-right corner).

2. Drag. (An outline of the window shows the
new size.)

Resizing a window             1. Place the pointer in the zoom box to show
all                              of its contents (in the window's upper-right

corner).
2. Click. (Click again to reverse the process.)

Closing a window              1. Place the pointer in the close box (in the
window's upper-left corner).

2. Click.

Another way to close a window: You can also close the active window by
choosing the Close command from the File menu or using the keyboard shortcut
Command-W.

Seeing other parts of a window by scrolling.  When you're working within a
window, you can easily change your view of the contents by scrolling. The
amount you see in the window at any one time depends on the window's size.

The up arrow displays content above the window's top border; the down arrow
displays content below the window's bottom border. The left and right arrows
display content beyond the left and right borders of the window,
respectively.

1.  To scroll through the content of a window, place the pointer on one of
the scroll arrows and hold down the mouse button.

The window's contents move to show the part that was hidden. The scroll box
also moves in the direction of the arrow.

2.  Release the mouse button when the item you want to see is visible.

Another way to use the scroll arrows: Simply click a scroll arrow to scroll
in small increments (about one-half inch when you're using the Finder).

Additional scrolling options.  You can also use the gray area of a scroll bar
or the scroll box to view a window's contents. 



Additional scrolling options

Task                                    Instruction
Example

Scrolling by the                   1. Place the pointer in the scroll bar.
windowful                          2. Click.

Scrolling to a specific            1. Place the pointer in the scroll box.
part of a window                   2. Drag.

Another way to see more of a window's contents: Making the window larger
displays more of its content. Clicking the zoom box displays all of a
window's contents (or as much as will fit on the Macintosh screen).

Using menus

Another of the standard Macintosh operations is using menus. Whether you are
working with the Finder or in an application program, you use menus in a
consistent way.

Certain menus and core commands are provided as part of nearly all Macintosh
software. These core elements include the Apple, File, Edit, Help, and
Application menus and commands such as Cut, Copy, and Paste. 

Menu bar with the Edit menu pulled down

Pulling down a menu.  The principal type of Macintosh menu is called a pull-
down menu.

1.  To pull down a menu, first point to the title of the menu you want in the
menu bar at the top of the screen.

2.  Press and hold the mouse button to open the menu.

The menu closes when you release the mouse button.

Choosing a menu.  You choose a command with the menu pulled down.

1.  To choose a menu command, first pull down the menu by pointing to its
title and holding down the mouse button.

2.  Drag the pointer to the command you want.

As you drag, each command that is not dimmed becomes highlighted when the
pointer is on it. (Dimmed commands are not available and thus cannot be
chosen.)

3.  Release the mouse button to choose the highlighted command.

The command blinks in the menu, then the menu closes and the command takes
effect.

Another way to choose a command: Many commands have a keyboard equivalent,
usually made up of the Command key and one or more other keys. Each of these
keyboard shortcuts is displayed to the right of the command it represents in



the menu.

"Using Special Keys and Indicators on the Keyboard" later in this chapter
"Adjusting the Blinking of a Menu Item" in Chapter 7

Using a submenu.  Some application program menus have submenus associated
with them. You choose commands from submenus by dragging, but the procedure
is a little different. A submenu is indicated by a small black triangle
pointing to the right, next to the command name. The submenu opens when the
menu item to which it belongs is highlighted.

1.  To use a submenu, first pull down its corresponding menu.

A small triangle at the right of a menu item shows that the item has a
submenu.

2.  Drag the pointer to the item with a submenu you want to open.

When the item is highlighted in the menu, the submenu opens.

3.  Drag sideways onto the submenu and then down until the command you want
becomes highlighted.

4.  Release the mouse button to choose the highlighted submenu command.

The command blinks in the submenu, then the submenu and menu close and the
command takes effect.

Using a pop-up menu.  Pop-up menus are similar to pull-down menus, but they
don't reside in the menu bar. A common example is the pop-up menu in the on-
screen box you use to open and save documents within an application program.
(This box is called a directory dialog box.)

A pop-up menu in a directory dialog box

This type of menu is used in some programs to choose settings or variables.

A pop-up menu can extend above or below its title, and some extend in both
directions. The item displayed as the menu title is the item that is
currently chosen.

1.  To use a pop-up menu, point to the menu's title and hold down the mouse
button.

The menu opens, showing some or all of the items available.

2.  Drag the pointer to the item you want in the pop-up menu.

The item becomes highlighted when the pointer is on it.

3.  Release the mouse button to select the highlighted item.

The pop-up menu closes and the item selected now appears as the menu title.

"Using a Directory Dialog Box" later in this chapter
"Moving Through Levels of Folders With a Pop-up Menu" in Chapter 5



Responding to messages on the screen

The Macintosh has several standard ways of displaying messages on the screen.
The most common form of message is a dialog box, which requires that you
choose an option or supply needed information before the Macintosh can
continue doing what you want it to do.

Some of the most frequently used commands on the Macintosh present dialog
boxes. For example, when you close a document, a dialog box appears with
three options: save the document and close it, close the document without
saving it, or cancel the action. 

A dialog box that alerts you to save changes before closing a window

You click one of the buttons in this dialog box to confirm the command you
chose. In some other dialog boxes, you may need to choose a name from a list
or type a name or number, and then click a button labeled "OK" before the
command takes effect. Menu commands that are followed by three dots always
display such a dialog box.

Using a directory dialog box.  When you're using an application program,
several commands, such as Open and Save As in the File menu, display a
directory dialog box, which shows a list of the files on the current disk or
in a folder. 

A directory dialog box

You select items and choose options in a dialog box with standard operations
-- scrolling, pointing, and clicking. Here's how you would use the directory
dialog box to open a document located on another disk.

1.  Click the Desktop button to display the names of other disks (and items
on the desktop).

A new list of names appears in the box when you click Open.

2.  Scroll, if necessary, to locate the disk you want, then click the name to
select it.

3.  Click the Open button to display the items on the selected disk.

The disk's contents are displayed when you click Open.

4.  Click the folder you want to select, and click the Open button to open
the folder.

The names of items in the folder are displayed when you click Open.

5.  Click the name of the document you want.

6.  Click the Open button to open the document.

The dialog box closes, and the document appears.

Another way to open a document or folder:  Double-clicking the name of a
document or folder in the list opens it.

"Using a Pop-Up Menu" earlier in this chapter



"Moving Through Levels of Folders With a Pop-up Menu" in Chapter 5

Using an alert box.  Another type of dialog box, the alert box, is designed
to keep you from accidentally losing some of your work or quitting an
application program. Its message warns you that you may be doing something
you didn't intend and asks you to confirm that you want to go ahead with the
action.

Many alert boxes are accompanied by a sound to warn you of a possible
mistake.

When you choose the Empty Trash command from the Special menu, you'll see an
alert box.

Return key shortcut:  You can press Return or Enter instead of clicking the
OK button. (Pressing Return or Enter is the same as clicking the button with
a bold outline in any alert box or dialog box.)

"Turning the Trash Warning On or Off" in Chapter 7
"Setting the Alert Sound" in Chapter 7

Getting help

The Macintosh system software has built-in explanations of most items that
appear on the computer screen. Each description is displayed in a small
balloon next to the item you are pointing to.

On-screen description of the Help menu

The Help menu is always available, whether you're using the Finder or an
application program. You can turn on the Help information at any time, even
when a dialog box is displayed on the screen. When Help balloons are turned
on, you can use your Macintosh as usual -- choosing menu commands, opening
windows, and so on.

The Help information describes menu commands, dialog boxes, icons, and
windows. Many application programs also provide information about their
features and commands in Help balloons.

The Help menu also provides a summary of shortcuts you can use when working
with the Finder.

Turning Balloon Help on and off.  You choose the on-screen descriptions --
called balloons -- from the Help menu (which has a question mark icon).

To turn on descriptions, choose Show Balloons from the Help menu.

You can turn off balloons by choosing Hide Balloons from the Help menu.

Basic editing

The Macintosh has a number of standard editing capabilities, which you can
use with the Finder or in any application program. These built-in features
allow you to change disk and document names with ease, to copy text or
graphics between programs, and to save frequently used information for quick
retrieval.

This section introduces the fundamental text-editing operations you can use



with the Finder or in application programs.

"Editing Documents" in Chapter 3

Changing all of an icon's name.  You can easily change an icon's name.

1.  To change an icon's name, first select the name by clicking it.

The icon's name becomes highlighted and a box appears around it. (You must
click the name. Clicking the icon highlights the name but does not select it
for editing.)

2.  Type a new name for the icon, then press Return to save the new name.

When you begin typing, the new text appears in place of the old. The
insertion point -- a thin vertical line that marks the place where text will
appear -- blinks at the end of the text you type.

Another way to select an icon's name:  Selecting the icon and pressing Return
selects its name.

Another way to save an icon's name change:  Clicking anywhere outside the
icon saves its new name.

Selecting part of the text in an icon's name.  You use dragging to select
part of an icon's text. You also use dragging to select text in application
programs.

1.  To select part of the text in an icon's name, select the name by clicking
it.

2.  Place the pointer over the icon's name.

When you place the pointer over the name, the arrow changes to an I-beam -- a
vertical symbol that resembles a capital letter "I."

3.  Position the I-beam just to the left of the first character you want to
select, then press the mouse button.

4.  Drag the I-beam across the text you want to select.

5.  Release the mouse button when the I-beam is just to the right of the last
character you want to select.

Another way to select text:  When you're editing text, you can select a word
by double-clicking it.

Replacing, deleting, or inserting text in an icon's name.  You use variations
of the technique for selecting text in an icon's name to replace or delete
part of the name and to insert text in the name. 

Editing an icon's name

Task                           Instruction
Example

Replacing text             1. Select the text to be replaced.
in an icon's name          2. Type the new text.



Inserting text             1. Place the I-beam pointer at the 
in an icon's name             place where text is to be inserted.

2. Click to set the insertion point.
3. Type the new text.

Deleting text              1. Select the text to be deleted.
in an icon's name          2. Press the Delete key.

Another way to delete text: You can also use the Cut command or the Clear
command in the Edit menu to delete selected text. The Cut command removes
text and places it in the computer's memory in an area called the Clipboard,
from which it can be pasted elsewhere. The Clear command simply removes the
text.

"Inserting Copied Text and Images Within a Document" in Chapter 3
"Deleting Text and Images" in Chapter 3

Using control panels

You can change many of the standard settings for your Macintosh by using the
control panels. The Macintosh system software includes a General Controls
panel for a variety of settings and separate panels for the mouse, keyboard,
sound, and many other components of your system.

Special control panels may be supplied with some Macintosh models; other
control panels are available from independent manufacturers.

Each control panel has its own icon and can be opened like the icon for a
program or a document. 

Icons of the standard control panels

Special control panels:  If your Macintosh has its own special control panel,
refer to the Special Features booklet or other documentation that came with
your Macintosh for details about using that control panel.

Control panel settings.  The settings you can adjust in the control panels
include

- the pattern on the desktop

- how many times menu items blink when you select them

- how fast the insertion point blinks

- the date, time, and display of 12-hour or 24-hour clock

- the speaker volume

- the alert sound

- how fast a character repeats when a key is pressed

- the distance the pointer moves on screen when you move the mouse

- the positions of multiple monitors

- the number of colors or shades of gray displayed



- the disk drive to be used for startup

- the labels and colors available for icons

- the layout of icons and the font used in the Finder

- the hard disk space used to expand system memory

- special aids for using the keyboard and mouse

- file-sharing setup and program linking (available to Macintosh computers on
a network)

"Basic Editing" earlier in this chapter 
"Specifying Items to Be Opened at Startup" in Chapter 2
"Adjusting the Disk Cache" in Chapter 3 
Appendix D, "Special Aids for Using the Mouse, Keyboard, and
Screen"
�Setting Up Your Macintosh on the Network," Chapter 2 of the Macintosh
Networking Reference

Opening a control panel.  The control panels are located inside a folder
named Control Panels, which is inside the System Folder. To open a control
panel, follow these steps:

1.  Choose Control Panels from the Apple menu.

The Control Panels folder opens.

2.  Open the control panel you want to use.

Double-click the control panel's icon, or select the icon and choose Open
from the File menu.

"Using an Alias for Easy Access to a File" in Chapter 5
"Customizing the Apple Menu" in Chapter 7

Changing settings in the control panels.  For most control panel settings,
you click a button to make a change.

A few settings, such as time and date, are adjusted by selecting one of the
existing numbers (the hour or month, for example) and then using small up and
down arrows to move to the desired number. (You can also type the number you
want.)

See also: Chapter 7, "Customizing Your Macintosh"

Using the Chooser

The Chooser is a desk accessory (a small application program) supplied with
your Macintosh. You use the Chooser to specify a printer to use. You also use
it to select devices such as shared disks on a network and to adjust some
printing and network settings. 

The Chooser is placed in the Apple menu when you use the Installer to install
the system software.

You open the Chooser by choosing it from the Apple menu.



Selecting a printer or other device in the chooser.  You designate a printer
or other device by selecting its icon, its location (if necessary), and its
name in the Chooser.

1.  Select the type of device you want to use by clicking its icon in the
upper-left area of the Chooser.

A bold border indicates which area is active.

2.  If your network has zones, select the zone in which the device is located
by clicking its name in the lower-left area of the Chooser.

If your network does not have zones, this list does not appear.

3.  Select the specific device you want to use by clicking its name in the
list at the upper-right area of the Chooser.

It's a good idea to close the Chooser when you're done.

Once you've selected the name of a device, such as a LaserWriter printer,
your Macintosh will use that device until you select a different one with the
Chooser.

Keyboard shortcuts for moving around in the Chooser:  You can press the Tab
key to move from one section of the Chooser to another, and you can type one
or more characters to move to the items in a section that begin with those
characters.

"Using the Keyboard to Move Around the Desktop or a Finder Window" later in
this chapter
"Working With Several Open Programs" in Chapter 3
"Printing While Using the Computer for Other Work" in Chapter 4
"Turning AppleTalk On or Off," Chapter 2 of the Macintosh Networking
Reference
"Connecting to a Shared Disk" in Chapter 3 of the Macintosh Networking
Reference

Using special keys and indicators on the keyboard

The Macintosh keyboard resembles a typewriter keyboard, but some of its keys
have special purposes. (Some keyboards do not include all of these special
keys and lights.)

Special keys and indicators used on Macintosh keyboards

The location of special keys varies on the different keyboards available for
use with Macintosh computers.

See also: Appendix A, "Keyboards and Character Sets
"Appendix D, "Special Aids for Using the Mouse, Keyboard, and Screen"

Using the keyboard to move around the desktop or a window.  You can use
certain keys to move quickly from one item to another. You can use these
shortcuts on the desktop, in Finder windows, in the Chooser, and in a
directory dialog box.

Keyboard shortcuts in the Finder, Chooser, and directory dialog boxes



Key                                  Action

Arrow keys                 Selects the next item in the direction of the
arrow

Tab key                    Selects the next item alphabetically (except in
directory dialog box and the Chooser)

Character                  Selects the first item whose name begins 
key (a, b, c...)           with that character (or the character closest to
it                         in the alphabet)

Command-Down Arrow         Opens the selected icon

Command-Option-Down        Opens the selected icon and closes the current
Arrow                      folder

Command-Up Arrow           Opens the folder that contains the current folder

Command-Option-Up          Opens the folder that contains the current folder
Arrow                      and closes the current folder

Return or Enter            Selects the selected icon's name for editing or
saves the edited name (except in a directory
dialog box)

Appendix A, "Keyboards and Character Sets"

Turning the Macintosh on and off

All models of the Macintosh computer (except the Macintosh Portable) have a
power switch on the back of the case. The location of the switch varies among
the different models, however, and the switch is not the recommended method
for turning some models on and off.

Locating the power switch.  On compact models, such as the Macintosh Classic
and the Macintosh SE/30, the power switch is located at the right rear side
of the computer. 

The power switch on the Macintosh SE/30

On models that have a separate monitor, such as the Macintosh II family and
Macintosh LC, the power switch is located on the left rear side of the
computer.

Power switch on the Macintosh IIci

Turning on a compact Macintosh or Macintosh LC.  You turn on a compact
Macintosh or a Macintosh LC with the power switch.

Turning on an external hard disk drive:  If your system has an external
hard disk drive, you should turn on the external drive before you turn on the
Macintosh. Otherwise, the Macintosh may not recognize the external drive.

Chapter 10, "Troubleshooting"

Turning on a Macintosh II-family computer.  The recommended way to turn on a



Macintosh II computer is by pressing the Power On key on the keyboard. This
key is located at the top of the keyboard and has a triangle symbol on it. 

The Power On keys on two kinds of Macintosh keyboards

If the Power On key doesn't work, you can use the power switch on the back of
the computer to turn on the computer.

Turning on an external hard disk drive:  If your system has an external hard
disk drive, you should turn on the external drive before you turn on the
Macintosh. Otherwise, the Macintosh may not recognize the external drive.

Chapter 10, "Troubleshooting" Appendix A, "Keyboards and Character Sets"

Turning off the Macintosh.  The recommended way to turn off all Macintosh
computers is to choose the Shut Down command from the Special menu. This
command prepares all files and disks in use for shutdown.

The Shut Down command turns off the power in some models of the Macintosh. In
compact models, this command prepares the system for shutdown and then
displays a message telling you it's safe to turn off the computer's power
switch.

"Shutting Down the Computer" in Chapter 3

CHAPTER 2-STARTING UP

Setting up your computer involves two tasks: assembling the hardware
components and preparing the system software, which the Macintosh uses for
its basic operations.

This chapter provides instructions for preparing the system software to work
efficiently with all parts of your Macintosh system.

Preparing the Macintosh hardware

The steps you need to follow in setting up your Macintosh hardware depend on
which model of computer you have. The setup guide that came with your
computer provides detailed instructions for putting the system together.

If you set up the Macintosh and the computer or monitor does not turn on, see
Chapter 10, "Troubleshooting," for assistance.

Preparing your system software

The system software manages Macintosh operations. It transmits information to
and from disks, printers, and other devices, establishes and keeps track of
files, and directs processing inside the computer. Most system software
activity is invisible, but application programs -- the software you use for
word processing, spreadsheets, and other specialized work -- rest on the
foundation system software provides.

Is your system software already installed?  If you purchased a Macintosh
with an internal hard disk drive, the system software probably was installed
for you. You'll recognize a ready-to-run Macintosh when you turn it on; after
a few seconds you'll see a "happy Macintosh" icon, then the desktop will
appear on the screen, with icons for the hard disk and the Trash. You can



skip the installation procedure if your Macintosh shows the desktop and these
icons.

The "happy Macintosh" icon displayed at startup

!!  WARNING:  If you purchased a hard disk with the A/UX operating system
installed on it, do not initialize that disk; doing so will erase A/UX.
Instead, see the A/UX documentation for instructions on installing system
software.  !!

You prepare the system software for your Macintosh by installing it on a
disk. That disk then becomes a startup disk. A startup disk is any hard disk
or floppy disk that contains the system software necessary to use your
Macintosh computer and the devices connected to it.

Installing system software creates a System Folder on the disk. This special
folder contains the system files, drivers, and other kinds of resources your
Macintosh needs. 

Icons for the System Folder, the System file, and the LaserWriter driver

"Using Folders Inside the System Folder" in Chapter 5

Installing system software.  You use a program named Installer to prepare the
system software for your Macintosh. You also use the Installer to update your
system with a new version of system software.

To install the system software, you will need an initialized hard disk and
the set of Macintosh system software disks supplied with your computer or
system software upgrade kit. The number of disks varies, according to whether
they are 1.4 MB (high-density disks) or 800K disks. One disk in each set is
named Install 1.

If your Macintosh is part of a network, you may be able to install system
software over the network. Ask your network administrator for more
information.

!!  IMPORTANT:  Your computer system must have a hard disk to use System 7.0
or later versions of the Macintosh system software effectively.  !!

The Installer provides two options -- Easy Install and Customize. These
instructions cover the Easy Install process, which is suitable for most
Macintosh users. (To learn more about the Customize option, see "Installing
System Software for Special Needs" later in this chapter.)

When you start the Installer, the software determines which model of the
Macintosh computer you are using and prepares to install the standard
software for that model.

You begin the installation procedure with your Macintosh turned off.

1.  To install the system software, put the Install 1 disk into the internal
floppy disk drive, and turn on the computer.

If your Macintosh has two floppy disk drives, you can use either one.

2.  Click OK once you've read the Welcome box.



The Easy Install dialog box appears.

3.  Make sure that the disk named on the screen is the one you want to
install on.

If the wrong disk name appears, click the Switch Disk button until the
correct disk name appears.

4.  Click Install.

The Installer begins to install the system software for your Macintosh model.
On-screen messages list the disks needed and report copying status.

5.  When the Install 1 disk is ejected and you see a message to insert a
different disk, insert the disk specified. Repeat this process as necessary.

You'll probably have to switch disks more than once.

6.  When you see a message reporting that the installation was successful,
click Quit.

The Installer window closes. (If for some reason the installation was not
successful, you'll see a different message, and you can begin installation
again.)

7.  Restart your computer.

The Macintosh restarts with the newly installed system. (If you installed
system software on a disk other than your current startup disk, you'll have
to designate that disk as the startup disk, and then restart again.)

"Starting Up With a Floppy Disk for Troubleshooting" later in this chapter
"Installing System Software Over a Network" later in this chapter
"Working With Desk Accessories" in Chapter 3
"Working With Fonts" in Chapter 4
"Designating a Startup Disk" in Chapter 6
"Preparing a New Hard Disk" in Chapter 6

Installing system software for special needs.  If your Macintosh uses devices
that are not included in the standard software, you can use the Customize
option of the Installer to install or modify your system.

Custom installation allows you to select the exact combination of system
files, drivers, and other resources you want. You can use this process for
initial installation, for updating to a new version of system software, for
installing a single special resource, or for saving space on your startup
disk by eliminating software that isn't essential.

You begin the installation procedure with your Macintosh turned off.

1.  To install customized system software, put the Install 1 disk into an
internal disk drive, and turn on the computer.

If your Macintosh has two floppy drives, you can use either one.

2.  Click OK to remove the Welcome box.

The Easy Install dialog box appears.



3.  Make sure that the disk named on the screen is the one you want to
install on.

If the wrong disk is named, click the Switch Disk button until the correct
disk name appears.

4.  Click Customize.

The custom installation box appears. All parts of the system software are
listed, and you have a choice of standard or minimal system files for each
model of the Macintosh computer.

5.  Scroll through the list 5 of items and Shift-click the ones you want to
install.

As you select items, their names appear in the lower portion of the dialog
box. (If you select only one item, details about it appear.)

6.  Click the Install button to install the selected items.

The installation begins. On-screen messages report status.

7.  If the Install 1 disk is ejected and you see a message to insert a
different disk, insert the specified disk. Repeat this process as necessary.

You may be asked to switch disks more than once.

Clicking the Stop button cancels the installation.

8.  When you see a a message reporting that installation was successful,
click Quit.

The Installer window closes. (If for some reason the installation was not
successful, you'll see a different message, and you can begin installation
again.)

9.  Restart your computer.

The Macintosh restarts with the newly installed system. (If you installed
system software on a disk other than the startup disk, you'll have to
designate that disk as the startup disk, and then restart again.)

"Working With Desk Accessories" in Chapter 3
"Working With Fonts" in Chapter 4
"Designating a Startup Disk" in Chapter 6

Installing system software over a network.  If your Macintosh is part of a
network system, you can install system software that's stored on a shared
disk (a file server or a Macintosh that contains shared files).

Once you've connected to the shared disk that contains the Installer and the
system software files, you start the Installer by double-clicking its icon.
Then you follow steps 2 through 7 in "Installing System Software" or steps 2
through 9 in "Installing System Software for Special Needs" earlier in this
chapter. When installing over a network you don't have to use floppy disks.

Conserving disk space with a minimal system.  There are two ways to save disk
space by eliminating unnecessary items from your System Folder. One way is to



create a small system by selecting the "Minimal software" option for your
Macintosh from the Installer's Customize dialog box. (Note that the "Minimal
software" option creates a System Folder that works only with your model of
Macintosh computer.)

If you did not install the minimal system, or if you've added drivers, fonts,
or desk accessories since installation, the second way to save space is to
remove items that aren't essential. You remove drivers and desk accessories
by dragging them out of the System Folder or one of the folders located
inside the System Folder. You remove fonts, sounds, and keyboard files from
the System file, which is inside the System Folder. You need to erase these
items to free the space they occupied on your hard disk. (Be sure to save
copies on backup disks.)

Depending on the devices connected to your Macintosh, you should consider
removing the following items if you want to create more room on your disk:

- drivers for printers or other devices you don't use (such as an
ImageWriter, AppleTalk ImageWriter, or LaserWriter printer)

- networking drivers, if you are not on a network (such as AppleShare
software)

- extra desk accessories (you may not need the Alarm Clock, Calculator, Key
Caps, Note Pad, Puzzle, or Scrapbook)

- extra fonts, sounds, or keyboard files

"Installing System Software for Special Needs" earlier in this chapter
"Working With Desk Accessories" in Chapter 3
"Working With Fonts" in Chapter 4
"Using Folders Inside the System Folder" in Chapter 5

Starting up with a floppy disk for troubleshooting.  Although you can't
create a version of System 7 small enough to work effectively on a floppy
disk, you can start up with the disk labeled Disk Tools in the internal
floppy disk drive if for some reason you're unable to use your hard disk.
This disk contains a System Folder with an earlier version of the system
software.

You can use the Installer to install System 7 on a high-density (1.4 MB)
floppy disk. This is recommended for temporary use only.

Chapter 10, "Troubleshooting"

Updating to a new version of system software.  If you have been using an
older version of the system software and you get a newer version, you can
update your system by using the Installer.

When you use the Installer to update your system, you retain the special
fonts, sounds, and drivers you've installed. (If you simply throw away your
current System Folder and replace it with the newer one, you lose these
special items.)

To install the new system software, follow the instructions in "Installing
System Software" or "Installing System Software for Special Needs" earlier in
this chapter.



"Updating Printer Drivers for Macintosh Computers Using System 7 and System 6
on a Network" in Appendix B

Specifying items to be opened at startup

You can designate one or more application programs, desk accessories, and
documents to be opened automatically when you start up the Macintosh.

Placing items in the Startup Items folder.  To specify items you want to open
at startup, you place their icons in the Startup Items folder, which is
inside the System Folder.

1.  Open the System Folder by double-clicking its icon.

2.  Locate the Startup Items folder and drag the item you want opened at
startup to its icon.

The item will be opened the next time you start up the Macintosh.

Using an alias in the Startup Items folder: You can also designate an item to
open at startup by making an alias (a substitute file) for the item and
placing the alias in the Startup Items folder.

"Putting a Program or its Alias in the Apple Menu" in Chapter 3
"Using an Alias for Easy Access to a File" in Chapter 5

Removing items from the Startup Items folder.  If items are opening at
startup that you don't want opened, you can remove them from the Startup
Items folder (which is inside the System Folder).

1.  Open the System Folder by double-clicking its icon.

2.  Locate the Startup Items folder, then double-click to open it.

3.  Select the items you want to remove and drag them to the folder where you
want to store them.

Be sure to drag the icons out of both the Startup Items folder and the System
Folder. If you leave them in the System Folder, they may still open at
startup.

The next time you start up or restart the Macintosh, the items you removed
from the Startup Items folder will not be opened.

"Putting a Program or its Alias in the Apple Menu" in Chapter 3
"Working With Several Open Programs" in Chapter 3
"Managing System Memory" in Chapter 3

CHAPTER 3-WORKING WITH APPLICATION PROGRAMS

Application programs determine what kinds of work you can do with a Macintosh
-- such as writing, drawing, designing, calculating, controlling a variety of
processes, and managing vast amounts of information.

This chapter outlines some fundamental operations common to all application
programs, regardless of the program's specific purpose and product.

These operations include



- preparing to use an application program

- moving text and images within a document

- copying text and images from one document to another

- saving documents -- under various names, in various locations

- storing frequently used text and images for easy access

- recognizing whether you're in an application program or in the Finder and
moving from one place to the other

This chapter also shows you how to manage several application programs at
once and summarizes the appropriate steps for ending a work session.

Preparing to use a program

You use standard Macintosh operations to install and start most programs, and
to create documents with them. Once you've created a document with a program,
you can either start the program and then open the document, or you can
simply open the document icon, which automatically starts the program.

Installing a program.  You can install many application programs simply by
copying them from the original disk to your hard disk. (Some programs have
more elaborate installation procedures. Check the documentation that came
with your program for any special instructions.)

1.  Open the program's disk by double-clicking its icon.

2.  Copy the program by dragging its icon to your hard disk.

You can also copy a program to a folder (by dragging its icon to the folder
icon) or to an open window (by dragging its icon to the window).

3.  If necessary, copy any additional files the program needs by dragging
their icons to the hard disk.

The documentation should specify whether any such files -- a help file or a
dictionary, for example -- are needed and whether they need to be put in a
special place, such as the System Folder.

It's a good idea to open the icon of the hard disk to make sure that the
program and other files were copied.

"Installing System Software" in Chapter 2

Creating an alias for a program.  You can make an alias for an application
program to give you quick access to the program from any location. For
example, you may have stored the program in a folder with documents created
by that program, or a program may need to be in a special folder with related
files. You can put the alias on the desktop where it's always available
without opening any folders. Or you can put the alias in the Apple menu.

An alias is essentially a representative of the original program or document
that you can use as if it were the original. It has the same icon as the
original but the name appears in italics.



The original and an alias for a program

An alias is not a copy of the program or document; it is a tiny file (about
1-2K in size) that directs the computer to the original. You can make any
number of aliases for an original file.

When you double-click an alias, the alias locates the original program and
the original opens.

Follow these steps to make an alias:

1.  Select the program or document by clicking its icon.

2.  Choose Make Alias from the File menu.

The alias appears next to the original program or document. It has the same
name as the original, followed by the word "alias." (You can change the name
if you wish.)

"Using an Alias for Easy Access to a File" in Chapter 5

Putting a program or its alias in the Apple menu.  You can get easy access to
any program, document, disk, or shared disk by putting it (or an alias for
it) in the Apple menu. Then you simply choose the item's name from the Apple
menu whenever you want to use that item.

To add an item to the Apple menu, you place its icon in the Apple Menu Items
folder, which is inside the System Folder.

1.  Double-click the icon of the System Folder to open it.

2.  Drag the icon of the program or its alias into the Apple Menu Items
folder inside the System Folder.

The item appears immediately in the Apple menu.

You remove a program or document from the Apple menu by opening the Apple
Menu Items folder and dragging the item out of the folder. The name
disappears from the Apple menu after you remove the icon from the Apple Menu
Items folder.

"Specifying Items to Be Opened at Startup" in Chapter 2

Starting a program.  You start a program by opening it. You can double-click
the program's icon or select the icon and choose Open from the File menu. You
can also open a program by double-clicking a document created by the program,
or by dragging the document to the program icon.

The program remains open until you quit, usually by choosing Quit from the
File menu (or by using the keyboard shortcut Command-Q provided in many
programs), or until you shut down or restart the computer.

See also: "Opening a Document While Using the Finder" later in this chapter
"Finding Out What Programs Are Open" later in this chapter"Specifying Items
to Be Opened at Startup" in Chapter 2

Creating a new document in a program.  You create a new document while
working in a program by choosing the New command. (Many programs



automatically open a new document when you start them.)

1.  Choose New from the File menu.

If another document was already open, the new one covers it. (Some programs
don't permit more than one open document at a time.)

Open an existing document in a program.  You open an existing document while
working in a program by using the Open command.

1.  Choose Open from the File menu.

The program's directory dialog box appears. This box contains a list of
documents the program can open and folders on the disk you're using.

2.  Locate the folder or disk that contains your document, and double-click
to open it.

If the document is on another disk, click the Desktop button to see the
available disks (and click Eject if you need to switch to a different floppy
disk).

If the document is stored inside several folders, you need to open each
folder in turn from the list.

3.  Double-click the 3 document to open it.

You can also select a name in the list and click the Open button to open it.

"Finding Out What Programs Are Open" later in this chapter

Opening a document while using the Finder.  If you are using the Finder
rather than working in an application program, you can open a document (and
start the program at the same time) by double-clicking its icon or by
selecting the icon and choosing Open from the File menu. (This technique may
not work if the program is already open.)

When you close any document, the program stays open until you quit, usually
by choosing Quit from the File menu (or by using the keyboard shortcut
Command-Q), or until you shut down or restart the Macintosh.

Another way to open documents:  You can also drag a document icon to the
program icon (make sure that the tip of the pointer touches the program
icon). If the program can open that document, the program icon becomes
highlighted. When you release the mouse button, the program opens the
document. This method works well if you want to open a document with a
program other than the one that created it.

"Working With Several Open Programs" (next section)
"Using a Directory Dialog Box" in Chapter 1

Working with several open programs

The Macintosh system software lets you keep several programs and desk
accessories open at the same time.

This means you can



- switch from one program to another quickly and easily

- copy and paste text and graphics between documents in different programs,
without having to close the documents or quit the programs

- easily start new programs, move or delete documents, and change floppy
disks while you're working

All open programs are listed in the Application menu, which always appears at
the far right side of the menu bar. The names of the open programs are listed
in this menu, and the icon of the program currently in use appears in the
menu bar. 

The Application menu at the right side of the menu bar

Each time you open a new program or desk accessory, its name and icon are
added to the Application menu. The other programs already open remain open
(and their names and icons remain in the Application menu).

To use multiple programs most efficiently, you should also know something
about your system's memory, discussed later in this chapter.

"Managing System Memory" later in this chapter
"Specifying Items to Be Opened at Startup" in Chapter 2

Switching programs.  You switch among open programs or desk accessories by
choosing their names from the Application menu in the right corner of the
menu bar. 

Menu bar with the Application menu pulled down

If a program's icon is dimmed in the menu, that means its windows are hidden.
You can choose it from the Application menu to display its windows again.

Choose the name of the program you want from the Application menu.

Other ways to switch programs:  You can also click in a document window or
double-click a program or document icon to switch programs. (If a program is
already open, its icon is dimmed.)

Starting a program when other programs are open.  You start a program that is
not currently open by locating its icon and opening it.

Locate the icon of the program you want and open it by double-clicking.

If the icon you want is on the desktop and is hidden, you can hide or resize
windows to get to the icon.

You'll see an alert box if there is not enough memory for the new program to
be opened. 

Alert box reporting insufficient memory

If you see this message or a similar one reporting that the program can be
opened but may run inefficiently, quit one of the open programs and try
opening the one you want again. You can check the Application menu to see
which programs are open.



"Hiding and Showing Windows on the Desktop" later in this chapter
"Managing System Memory" later in this chapter

Returning to the Finder from an application program.  To return to the Finder
when you're using an application program, simply click any object on the
desktop (outside the open windows) or choose the Finder from the Application
menu at the far right side of the menu bar. When you do this, the active
window becomes inactive and the Macintosh icon appears in the upper-right
corner of the menu bar, indicating that you're using the Finder. The menus on
the menu bar also change.

Finding out what programs are open.  If you have several programs and windows
open, you can quickly find out which program is active and what other
programs are open by pulling down the Application menu (at the right side of
the menu bar).

The Application menu also contains three commands to let you hide the windows
of one or more programs or show all open windows.

You can click any window to make its program active.

Hiding and showing windows on the desktop.  You can hide all the open windows
except those of the program you're currently using by choosing a command in
the Application menu. (This is useful if you're getting confused by too many
windows on the screen or if you want to get to an item on the desktop.)

The windows remain hidden until you switch to another open program, at which
time its open windows are again displayed.

Another way to hide windows:  Choosing the first command in the menu hides
the windows of the program that's currently active.

"Switching Programs" earlier in this chapter

Editing documents

The Macintosh computer has standard operations built in that allow you to
edit text and to copy both text and images from one part of a document to
another, from one document to another, and from one program to another.

Editing text.  You can use the standard text-editing operations whether
you're in the Finder or using an application program. These include

- selecting text

- replacing text

- inserting text

- deleting text

You may want to review the instructions in "Basic Editing" in Chapter 1 for
basic text editing.

Copying text and images.  You can easily copy selected text and images.

1.  Click or drag to select the item you want to copy.



The program's documentation will tell you the method to use.

2.Choose Copy from the Edit menu.

Your selection is copied and stored in a part of the computer's memory called
the Clipboard; it remains there until you copy or cut another item or you
turn off the computer.

Keyboard shortcut for copying:  You can also use the keyboard shortcut
Command-C to copy selected items.

To check the Clipboard:  You can see the current contents of the Clipboard by
choosing the Show Clipboard command from the Edit menu. This command is
available in some programs, and it's always available when you're working
with the Finder. (Some kinds of information may not be visible, however.)

"Deleting Text and Images" in Chapter 3

Inserting copied text and images within a document.  Once you've copied text,
images, or both, you can insert that material in another open document. The
document into which you want to copy an item must be able to accept that
item; not all programs produce compatible information.

1.  Click at the exact spot where you want the item to appear.

In many programs, a blinking insertion point appears at the spot where you
click.

2.  Choose Paste from the Edit menu.

The item you copied previously is inserted.

3.  Check the document to make sure that the copied item was inserted as you
want it.

In some graphics programs, you need to position the item after you've pasted
it.

The copied item remains on the Clipboard; you can paste it as many times as
you wish.

Keyboard shortcut for pasting:  You can also use the keyboard shortcut
Command-V to paste copied material into a document.

Copying text and images between different programs.  You can easily copy text
and images from one document to another or from one program to another, if
the two programs produce compatible information. The instructions that follow
cover the task of copying between documents in two different programs.

1.  Open both documents to prepare for copying and inserting.

If your system doesn't have enough memory to have both documents open at
once, open the source document -- the one from which you want to copy.

2.  Click the window of the source document to make it active, and select the
material to be copied.

In a graphics program, a selection is often marked by handles or a moving



dashed outline; in a text program, a selection is highlighted.

3.  Choose Copy from the Edit menu.

The selection is copied to the Clipboard.

4.  Click anywhere in the window of the document in which you want to paste
the material.

If that window is not open, double-click the icon of that document--the
destination document--to open it. You may need to quit the program from which
you copied material.

5.  Click at the exact spot where you want the item to appear.

In many programs, a blinking insertion point appears at the spot where you
clicked.

6.  Choose Paste from the Edit menu.

The selected item appears at the insertion point or the spot where you
clicked.

7.  Make sure that the copied material was pasted where you want it.

When you paste something, it appears selected. You can delete it and paste it
again, or drag it to a new location, depending on the program you're using.

"Updating Documents Automatically With Publish and Subscribe" later in this
chapter
"Switching Programs" earlier in this chapter
"Starting a Program When Other Programs Are Open" earlier in this chapter

Deleting text and images.  You can delete text and images from a document in
either of two ways.

One method, using the Cut command, places the deleted material in an area of
the computer's memory called the Clipboard so that you can get it back (until
you copy or cut another item).

The second method, using the Clear command, removes the material and does not
place it on the Clipboard.

1.  Select the item to be removed.

The selection becomes highlighted (if it's text) or enclosed by a moving
dashed outline or handles (if it's a graphic image).

2.  Choose Cut or Clear from the Edit menu.

The selected item disappears from the screen.

Another way to clear text and images: Pressing the Delete key also clears
selected material.

Canceling and editing action.  You can cancel many editing actions with the
Undo command, which in many programs reverses your most recent action (if it
is possible to reverse that action).



The actions that you can undo vary among programs. The command is dimmed if
it's not available.

If Undo is available, choose it from the Edit menu.

Choosing Undo a second time restores your original action.

Keyboard shortcut for Undo: You can use the keyboard shortcut Command-Z to
choose the Undo command.

Saving documents

Saving your work often is the best safeguard against losing information.
Macintosh programs offer several ways to save documents, providing great
flexibility in managing and storing your work.

When you save, you can

- name the document

- change its name

- change its location

- save revisions with no change in name or location

- save all or part of a document in the Scrapbook desk accessory for quick
access

Most saving options use a form of the directory dialog box, in which you name
a document and select its storage location. 

A directory dialog box for saving files

Saving a new document.  When you create a new document and save it for the
first time, you need to name it.

When a document has not yet been named, the directory dialog box
automatically appears when you choose the Save command. This dialog box also
appears when you choose the Save As command.

1.  Choose Save from the File menu.

The directory dialog box opens. The name "Untitled" is selected (if the
document hasn't been saved before).

2.  Type a name for the document.

The name you type replaces the selected text in the box.

If you make a typing error, you can use the Delete key to backspace, or you
can select the part of the name to be corrected, and then retype.

3.  Click the Save button to save the document.

The program saves the document and the dialog box closes. The name of the
document now appears in the window's title bar.



Another way to save:  Some programs, such as HyperCard and many database
programs, save your document automatically after you make a change and when
you close the document. In these programs, you name a document at the time
you create it.

Summary:  Saving documents with revisions, new names, or in new locations.

Saving documents with revisions, new names, or in new locations

Task                               Instruction
Example

Saving a revised           1. Make the revisions.
document without           2. Choose Save from the File menu
keeping the original

Saving a document          1. Choose Save As from the File menu.
under a new name
(the original remains      2. Replace the current name by typing a new name.
on the disk)

3. Click the Save button.

Saving a document         1. Choose Save As from the File menu.
under the same
name in a new             2. Open a folder (or create a  new folder) where 

this  copy of the document will be stored
location on the
same disk 

3. Click the Save button.

Saving a document         1. Choose Save As from the 
under the same               File menu.
name on the               2. Click the Desktop button. 
desktop                   3. Click the Save button.

Keyboard shortcut for saving:  You can save revisions most efficiently by
using the keyboard shortcut Command-S, which is available in many programs.

When you save a document with a new name, the original document (with its
original name) remains on the disk, in the version you last saved before
changing the name. To avoid confusing different versions of a document, it's
a good idea to include a number, date, or other identifier whenever you
change a document's name.

To rename a document without retaining a version under the old name, rename
its icon in the Finder.

If the disk or folder you're using already contains a document with the same
name, you'll see a message alerting you that the version you're saving will
replace the one already there. 

Dialog box to confirm replacing old version with new

You can avoid replacing the existing document by clicking Cancel. Clicking
Replace replaces the existing document with the new one.

S"Basic Editing" in Chapter 1
"Moving, Copying, and Renaming a Document " in Chapter 5



"Using Folders to Organize Your Work" in Chapter 5

Saving a document on a different disk.  You can easily change the disk on
which you plan to store a document.

1.  Choose Save As from the File menu.

The directory dialog box opens, with the document's name selected.

2.  Click the Desktop button to display the names of other available disks.

You can save the document on a disk, directly on the desktop, or in a folder
that's on the desktop.

3.  Double-click the name of the disk you want to open.

If you're using floppy disks, you may have to eject a disk by clicking the
Eject button and then inserting the desired disk.

4.  If you wish, double-click a folder in which to store the document. Then
click Save.

Any further changes you make in the document will be saved on the new disk.

If the disk or folder you're using already contains a document with the same
name, you'll see a message alerting you that the version you're saving will
replace the one already there. 

You can avoid replacing the old version by clicking No in the alert box and
giving the document a different name. Clicking Yes replaces the old version
with the new one.

Saving text, images and sounds in the scrapbook.  The Scrapbook desk
accessory provides an excellent storage place for text, images, sounds, and
other material you use frequently. The Scrapbook is automatically included
when you install system software. 

The Scrapbook desk accessory

When the Scrapbook is open, the standard editing commands Cut, Copy, and
Clear operate on the contents of its window.

To copy an image to the Scrapbook, follow these steps:

1.  In your document, select the material you want to copy.

The selection will be highlighted or it will have a moving dashed line or a
box with handles around it, depending on the program you're using.

2.  Choose Copy from 2 the Edit menu.

The selection is copied onto the Clipboard in the computer's memory.

3.  Choose Scrapbook from the Apple menu.

The Scrapbook window opens, displaying the first item in the Scrapbook.

4.  Choose Paste from the Edit menu.



The selection is pasted before the item displayed.

5.  Close the Scrapbook by clicking its close box.

Keyboard shortcuts for Copy and Paste:  You can use keyboard shortcuts to
copy and paste -- Command-C for Copy, Command-V for Paste.

You can use the following editing commands in the Scrapbook:

- Cut (deletes the item displayed and stores it on the Clipboard)

- Copy (copies the item displayed and stores the copy on the Clipboard)

- Clear (deletes the item displayed)

Playing a sound in the Scrapbook:  Some application programs let you copy and
paste sounds into the Scrapbook. To hear a sound that has been pasted into
the Scrapbook, click the Play Sound button.

You can create more than one version of the Scrapbook, but the system can
work with only one Scrapbook file at a time. If you maintain several
Scrapbook files, be sure to store them under different names so that you
don't inadvertently replace one of them.

To swap Scrapbook files,

- remove the current Scrapbook File from the System Folder and give it a
different name

- then rename the new file "Scrapbook File" and place it in the System
Folder.

Updating documents automatically with publish and subscribe

In addition to copying text and images from one document to another, you can
now copy and paste material in documents that is updated automatically when
you make changes to the original.

Automatic updating is available only in certain application programs. If a
program offers this capability, its Edit menu will include commands that use
the terms "Publisher" and "Subscriber". 

The Edit menu for a program with automatic updating capability

Copies selected material into a special document called an edition that is
updated whenever the original is changed

Lets you select timing of updates, locate files, and cancel updating (changes
to Publisher Options when a publisher is selected)

Displays a dialog box that lets you select and insert an edition in the open
document

Understanding publishers, subscribers, and editions.  The automatic updating
capability is essentially dynamic or automated copying and pasting of
material from one document to one or many other documents.

To use this capability, you designate the material you want to have updated



automatically; it is called a publisher. This material is saved as a file,
called an edition. (If you designate two different parts of a single document
as publishers, the Macintosh makes two separate edition files.)

You can then open a document and indicate where you want the material in the
edition inserted; the inserted material is called a subscriber. When you
later edit the original version of the material (the publisher), your changes
are automatically saved in the edition and inserted in documents that contain
subscribers to that edition. You can designate as many subscribers to an
edition as you want, and those documents can be located anywhere -- even on
another disk or on a Macintosh or file server on a network.

Examples of a publisher, an edition, and subscribers

You can create a publisher while working in an application program that
supports the publish and subscribe features.

1.  Select the item you want to make into a publisher.

You must be using a program that supports publishers and subscribers.

2.  Choose Create Publisher from the Edit menu.

When you create a publisher, the information is saved in an edition (a
separate file that's updated when you change the original material).

You can save the edition anywhere you like.

3.  Type a name for the edition (the separate file that contains the material
you selected).

4.  Click the Publish button.

The selected item becomes a publisher, and the edition file you named is
saved in the location you specified. The publisher stays in your original
document.

The edition you named when creating a publisher contains the material you
selected. This file has its own type of icon and can be opened but not
edited. (You change the material by editing the publisher -- the material you
selected -- in the original file. You can recognize a publisher by its
special border.)

The icon and window for an edition named "Oct. sales"

Creating a subscriber.  Once you've created an edition, you can put it in one
or more documents.

1.  Open the document in which you want to insert the edition, and set an
insertion point.

You must be using a program that supports publishers and subscribers.

2.  Choose Subscribe to... from the Edit menu.

A dialog box opens, showing a list of editions that can be inserted in the
open document. The edition used most recently is selected.



3.  Use the dialog box to locate the edition you want, and click to select
it.

You can recognize an edition by its icon.

4.  Click the Subscribe button.

When you click, the edition's content -- updatable material -- is inserted in
the open document.

5.  Check that the subscriber appears where you want  it in the document.

If necessary, you can reposition the subscriber in the usual way -- by
selecting and cutting it, then pasting it in the right place.

The subscriber remains in your document until you cancel it, change its
status, or cancel the publisher to which it subscribes.

Publisher and subscriber options.  You can specify certain options for
publishers and subscribers, including how and when subscribers receive the
latest changes to the edition.

Publisher and subscriber options allow you to

- update editions automatically or manually

- cancel the publisher or subscriber currently selected (cancellation means
that the material is no longer automatically updated)

- open the publisher of the selected material

- see the location of the current publisher or subscriber in a pop-up menu

- see the date and time that the edition was most recently updated

Consult the documentation that came with your application program for
complete details about creating and using publishers, subscribers, and
editions.

You set options for a publisher by selecting it in the original document and
choosing Publisher Options from the Edit menu. 

The dialog box for publisher options

You set options for a subscriber by selecting it in a document and choosing
Subscriber Options from the Edit menu. 

Sample uses for publishers and subscribers

Files containing publishers                  Files containing subscribers

The drawings made by                         The master documents
an artist for a report                       belonging to a writer

preparing and revising the
report



Charts, tables, and financial data           Documents belonging to
prepared by a manager or statistician        members of a work group

who use the charts for
status reports, budgets, or
presentations

Templates prepared by                        Documents belonging to
an administrator                             members of  a group who use

templates to prepare their
work

Using publishers, subscribers, and editions is especially useful for
documents that are shared by Macintosh computers on a network, because the
information can be updated over the network.

"Networking Features of Your Macintosh" in Chapter 1 of the Macintosh
Networking Reference
"Linking Programs Over the Network," Chapter 6 of the Macintosh Networking
Reference

Creating document templates

Most documents created with an application program can be saved as or
converted into a stationery pad, which is a template form of the document.
The template retains the format and content it had at the time you made it
into stationery, and you can use it repeatedly as a master for similar
documents.

Making a document into a stationery pad using an application program.  .
Many application programs allow you to save a document as a stationery pad.
You can determine if a program offers this feature by opening a document and
choosing Save As from the File menu; if the dialog box contains a stationery
option, clicking it before saving will make the document into a stationery
pad.

The Save As dialog box from TeachText, a program that supports stationery

Making a document into a stationery pad using the Finder.  If the program
you're using does not include a stationery pad option, you can use a
document's Info window to create a stationery pad.

1.  Select the document you want to make into a stationery pad.

2.  Choose Get Info from the File menu.

The Info window for the document is displayed.

3.  Click the box labeled "Stationery pad" at the bottom of the window.

When you click, the icon in the Info window changes to resemble a pad of
paper.

4.  Click the close box to save the document as a stationery pad.

The document's icon now resembles a stationery pad.

To change the document back to a regular file, you uncheck the box labeled
"Stationery pad" in the Info window..  Using a stationery pad



Once you've made a document into a stationery pad, you open it like any other
document -- by double-clicking its icon or by selecting it and choosing Open
from the File menu.

If the stationery pad belongs to a program that supports stationery, a new,
untitled document opens. You then add the content you want and save the
document, naming it when you save.

If a stationery pad belongs to a program that does not support stationery,
you name the new document when you open the stationery pad. The steps that
follow present this procedure.

1.  Double-click the icon of the stationery pad you want to use.

A dialog box appears asking you to name the document.

2.  Type a name for the new document.

You can use the Save In button to specify a different location for the new
document.

3.  Click OK to open the new document.

The new document is a regular document, not a stationery pad.

Working with desk accessories

Some desk accessories -- essentially small application programs -- are
supplied with the Macintosh system software, and many others are provided by
independent manufacturers.

You can use desk accessories like other programs, opening them by double-
clicking their icons, putting them in the Apple menu, or creating aliases for
convenience and easy access.

Many desk accessories that were created for earlier versions of the system
software can also be used with the current software. You can recognize these
older desk accessories by their special icon. 

Icon for desk accessories released before version 7.0

Using a desk accessory from an earlier version of Macintosh system software.
A desk accessory file with a suitcase icon may contain one or more desk
accessories. You need to remove the desk accessories from the suitcase in
order to use them. You can then put the desk accessories you want to use in
the Apple menu, on the desktop, or in another convenient location.

1.  Double-click to open the desk accessory file.

The file opens into a window that contains an icon for each desk accessory.

2.  Drag the item you want out of the window and put it in a convenient
location.

If you drag a desk accessory to the System Folder, you will be asked whether
you want it placed in the Apple Menu Items folder. If you click OK, the desk
accessory will be available from the Apple menu.



You can discard the empty suitcase by dragging it to the Trash.

Managing system memory

Occasionally you may need to make an adjustment in your use of the computer's
random-access memory (RAM) in order to work efficiently with large programs
or with several programs at once.

Becoming familiar with the amount of memory your Macintosh has and the memory
requirements of the programs you use can help you take full advantage of the
computer's capabilities.

Some models of the Macintosh can use part of a hard disk's available space as
virtual memory -- an extension of the computer's RAM that can be used for
opening programs and creating documents.

Minimum memory requirements.  Your computer must have 2 megabytes (MB) of RAM
to use version 7.0 (or later) of the Macintosh system software. Two megabytes
usually allows you to open one program and one or more desk accessories, or
two programs that do not require large amounts of memory.

Most Macintosh computers can use 4 MB of system memory or more; consult the
Special Features booklet for your model (or the documentation that came with
your computer) for its memory capabilities.

Checking memory use in your Macintosh.  You can check your system's total
memory and the amount of memory being used by each open program in the About
This Macintosh window. 

Memory information about the Macintosh

1.  Make the Finder active by choosing it from the Application menu.

2.  Choose About This Macintosh from the Apple menu.

3.  Click the close box to close the window.

Consult your authorized Apple representative if you want to add more RAM to
your Macintosh.

See also: "Expanding System Memory With Hard Disk Space" (the next section)

Expanding system memory with hard disk space.  Some Macintosh computers can
use hard disk space to increase the computer's memory. The disk space, called
virtual memory, is not available for storing information when it is being
used for this purpose. If your Macintosh can use virtual memory, the Memory
control panel includes virtual memory controls.

The icon and window of the Memory control panel

Your Macintosh should contain enough built-in RAM for your regular needs --
that is, for the programs you frequently have open simultaneously.  You can
use virtual memory when you want to open additional programs or to work with
extremely large documents.

The Memory control panel is preset to allot the same amount of virtual memory
as the amount of RAM installed in your Macintosh. Choosing a larger amount of
virtual memory is likely to slow the computer's performance.



Virtual memory is more effective when you are using several small programs
simultaneously. It is less effective when using one very large program.

!!  IMPORTANT:  When you turn on virtual memory, the system software sets
aside a large amount of space on the hard disk being used for virtual memory.
For example, if your Macintosh has 4 MB of RAM and you add 2 MB of virtual
memory, 6 MB of space on your hard disk will be set aside.  !!

Before you can turn on virtual memory, you need to update your Apple hard
disks using the Apple HD SC Setup program, which is on the Disk Tools disk.
Begin this procedure with the Macintosh turned off.

1.  Insert the disk labeled Disk Tools and turn on the computer.

2.  Open the disk icon.

Double-click the icon, or select the icon and choose Open from the File menu.

3.  Open the Apple HD SC Setup icon.

4.  Click Update to update the selected hard disk.

If you have more than one hard disk, you can click Drive to select a
different disk and then click Update. Repeat this procedure until you have
updated all your hard disks.

5.  After you have updated all of your hard disks, click Quit.

6.  Choose Restart from the Special menu.

The Disk Tools disk is ejected, and your computer restarts.

Now you can turn on virtual memory.

7.  Choose Control Panels from the Apple menu.

The Control Panels window appears.

8.  Open the icon for the Memory control panel.

9.  Click the On button to turn on virtual memory.

The pop-up menu becomes available when you click On.

10. Use the pop-up menu to select the hard disk on which space will be
allocated for virtual memory.

11. If necessary, click the up or down arrow to adjust the amount of disk
space to be used as virtual memory.

It is recommended that you accept the preset size.

12.  Choose Restart from the Special menu.

After restart, the total memory available for application programs -- which
you can see in the About This Macintosh window -- includes the disk space you
designated.



"Checking Memory Use in Your Macintosh"(the previous section) "Adjusting the
Disk Cache" later in this chapter
"Turning On 32-Bit Addressing" later in this chapter

Clearing system memory that has become fragmented.  When a program opens, it
reserves a block of memory for itself. If you've opened and closed a number
of programs, your Macintosh memory can become fragmented. When this happens,
you may not be able to open another program, even if you know that your
Macintosh usually has enough memory to open that program. You may be able to
solve this problem by quitting some or all of the programs you have open,
then starting them again. Restarting the Macintosh also corrects the problem.

Changing the amount of memory a program uses.  On rare occasions you may need
to increase or decrease the amount of memory a program sets aside for itself.
You might want to open more documents at once, or you might want to decrease
the program's memory allocation so that you can open more programs at once.
You can do this by adjusting the program's memory size in its Info window.

1.  Quit the program if it's open, then click the program's icon to select
it.

2.  Choose Get Info from the File menu.

The Info window appears.

3.  Drag across the number in the box labeled "Current size" and type a new
number that's larger than the suggested size.

Making the program smaller than the suggested size may cause it to work more
slowly or may cause other problems.

4.  Close the Info window.

If you type a number that's too small, you'll see a message asking whether
you want to make it smaller than the suggested minimum size. Click Cancel.

The next time you start the program, it will set aside the new amount of
memory you allocated.

Adjusting the disk cache.  The disk cache in your Macintosh affects the
number of programs and desk accessories you can use simultaneously.

The disk cache is memory set aside to help programs work more quickly and
efficiently. The memory assigned to the disk cache is not available for
opening more programs or documents, however.

The preset and maximum sizes of the disk cache depend on the amount of RAM in
your Macintosh. If you often want to open more programs than memory allows,
try setting the disk cache to a smaller size -- such as 32K or 64K.

You set the disk cache in the Memory control panel, located in the Control
Panels folder in the Apple menu. The sections for virtual memory and 32-bit
addressing do not appear in all models of the Macintosh.

Memory control panel showing disk cache adjustments

1.  Click the up or down arrow to adjust the size of the disk cache or click
Use Defaults to use the preset size.



The Use Defaults button also sets virtual memory to the preset amount.

2.  Choose Restart from the Special menu.

The new size of the disk cache takes effect when the Macintosh restarts.

Turning on 32-bit addressing.  Some Macintosh computers can use very large
amounts of RAM (more than 8 MB, for example) by taking advantage of 32-bit
addressing. The Memory control panel for these computers allows you to turn
32-bit addressing on and off. 

Memory control panel showing 32-bit addressing option

If you want to use two or more very large programs or work with several very
large documents simultaneously, the combination of greatly expanded RAM and
32-bit addressing is especially valuable for working efficiently.

The 32-bit addressing section doesn't appear in the Memory control panel if
your Macintosh does not have this capability. (You can also consult the
Special Features booklet for your Macintosh or other documentation to find
out if your computer has this capability.)

1.  Click the appropriate button to turn 32-bit addressing on or off.

2.  Choose Restart from the Special menu.

The change takes effect when the Macintosh restarts.

Ending a work session

When you've finished your work -- with a program or for the day -- it's a
good idea to make backup copies of your new work and perform a couple of
maintenance tasks before leaving the computer.

Quitting an application program.  If you are finished using a program, use
the Quit command to close all the program's windows and quit the program.

1.  Save any work you did since you last saved the current document.

It's good practice to save your work often -- every ten minutes or so while
working actively in a document.

2.  Choose Quit from the File menu.

Backing up the session's work.  If you didn't make backup copies of your work
when you saved it, be sure to copy any important documents you've revised
during the session. It's safest to copy your work onto a disk different from
the one on which the original documents are stored.

1.  Insert a backup disk in one of the system's disk drives.

You can back up onto a hard disk, but it's safest to keep floppy disk backups
as well.

2.  Copy the new and changed files by dragging their icons to the icon of the
backup disk.

"Making a Backup Copy of a Disk" in Chapter 6



"Backing Up the Information on a Hard Disk" in Chapter 6

Shutting down the computer.  When you have finished work for the day and have
backed up your work, you can turn off the Macintosh. (Although you can safely
leave your computer turned on if you wish, it's a good idea to turn the
computer off if you will not be using it for a long period of time.)

If you have a Macintosh Portable, it's recommended that you put the computer
to sleep rather than shutting down. (See the Macintosh Portable Handbook for
more information.)

The procedure for turning off the Macintosh varies depending on the model you
use, but you should always use the Shut Down command before turning off the
power switch.

!!  IMPORTANT:  Always use the Shut Down command before turning off your
Macintosh. This command prepares the system software for shutdown. You may
damage your information or your software if you regularly turn off the
Macintosh without using the Shut Down command.  !!

1.  Choose Shut Down from the Special menu.

Some models of the Macintosh turn off automatically when you choose Shut
Down. Others display a message on the screen telling you that it's all right
to turn off the switch.

2.  If necessary, switch off the computer.

See also: "Using Special Keys and Indicators on the Keyboard" in Chapter 1
"Turning the Macintosh On and Off" in Chapter 1

CHAPTER 4-PRINTING DOCUMENTS AND WORKING WITH FONTS

The Macintosh provides several different ways to print documents, whether you
are using a program or working in the Finder.

This chapter explains the preparations you need to make for printing,
summarizes the options you can choose for paper, image size, and print
quality, and presents brief instructions for each printing operation.

Getting ready to print

Before you can print a document, you need to connect a printer to your
Macintosh and prepare the system software to use the printer.

"Using Fonts With Printers and Other Peripheral Devices" in this chapter 
"Connecting a Printer" in Chapter 8

Placing printer drivers in the System Folder.  A printer driver for each type
of printer you want to use must be in your System Folder. (A printer driver
is software that allows the Macintosh to communicate with a particular type
of printer.)

The icons for the LaserWriter and ImageWriter printer drivers

The printer drivers supplied with the system software may change to
accommodate new printing capabilities or new printer models. The manual for



your printer will provide information about any significant changes in
printer drivers, and a driver is included with every Apple printer.

If you've installed system software on a hard disk using the Easy Install
method, you can skip the following procedure; the Installer copies all the
printer drivers and the PrintMonitor program to the System Folder.

You can also use the copy of the Installer on the Printing disk supplied with
the system software to install printer drivers.

To print with a LaserWriter while doing other work with the computer, be sure
that the PrintMonitor program and the LaserWriter driver are in the
Extensions folder inside the System Folder.

Drag the driver icon for each printer you want to use to the System Folder on
your startup disk

If you want to print with a LaserWriter, be sure to include the PrintMonitor
program.

"Printing While Using the Computer for Other Work" later in this chapter 
"Updating Printer Drivers for Macintosh Computers Using System 7 and System 6
on a Network" in Appendix B

Choosing a printer.  You can have several output devices, such as printers,
connected to your Macintosh -- directly or on a network. You select the
printers and other devices you want to use with the Chooser.

The Chooser window

You select a printer with the Chooser open (you open the Chooser by choosing
it from the Apple menu).

1.  Click the type of printer you want to use in the upper-left area of the
Chooser.

2.  If necessary, select the zone your printer is in by clicking its name in
the lower-left area of the Chooser.

The list of zones appears only if your Macintosh is on a network that has
zones.

3.  Select the specific printer you want to use by clicking its name in the
list in the upper-right area of the Chooser.

Your choice takes effect immediately. It's a good idea to close the Chooser
after you've chosen a printer.

Choosing a printer that's directly connected:  When you use the Chooser to
select an ImageWriter or other printer that is connected directly to your
Macintosh, you follow a similar procedure, except that you don't select the
name of a printer. Instead, you specify whether your printer is connected to
the printer port or the modem port by selecting the icon for the port to
which your printer is connected.

"Connecting a Printer" in Chapter 8

Selecting Page Setup options.  You use the Page Setup dialog box when you've



selected a new printer in the Chooser or when you want to use a different
paper size or printing option.

Choose Page Setup from the File menu and select the options you want.

The preset choices (or those selected most recently) are displayed when the
dialog box opens.

Page Setup dialog box for the LaserWriter

You can choose Show Balloons from the Help menu to get descriptions of the
enhancements provided in the Options dialog box, or check your printer's
manual for details.

Page Setup dialog box for the ImageWriter

You'll see different options depending on the type of printer you're using.
Some programs provide additional options in their Page Setup dialog boxes.

Selections made in the Page Setup dialog box remain in effect until you
change them.

Printing your work 

Printing while using an application program is probably the most common
method, but the Macintosh also lets you print documents from the Finder.

When you begin printing (by choosing the Print command from the File menu),
you use the Print dialog box to specify printing options.

The Print dialog box for the LaserWriter

Printing color or gray-scale documents:  You can print color or gray-scale
documents on any color printer that can use the LaserWriter driver. If you
print a color document on a printer that prints only in black and white, the
document will be produced in a halftone format; that is, it will be composed
of patterns of dots.

Other printers offer different options in the Print dialog box. Some programs
offer additional printing options, such as the order in which a document's
pages are printed.

Printing from within a program.  You can easily print a document while
working in a program's active window.

Choose Print from the File menu, then select the options you want in the
Print dialog box and click Print.

After a moment, a status box appears. (If you're using a LaserWriter and the
PrintMonitor program, the status box disappears after a few seconds, and you
can resume other work while printing continues.)

Keyboard shortcuts for printing: You can use the keyboard shortcut Command-
P to initiate printing in most programs, and you can press Return instead of
clicking Print in the Print dialog box.

See also: "Preparing to Use Background Printing" later in this chapter
"Managing Printing Jobs" later in this chapter



Printing from the Finder.  You can print one or more documents from the
Finder -- without starting their programs first.

Select the documents you want to print, choose the Print command from the
File menu, then select the options you want in the Print dialog box and click
Print.

If the documents were created by different programs, you need to select
options in each Print dialog box that appears.

Keyboard shortcut for printing:  You can press Return or Enter instead of
clicking Print in the Print dialog box.

"Using a List View to See Several Levels of Files" in Chapter 5

Printing the contents of a window.  You can print the contents of an active
window when you're working in the Finder. 

Printed version of a window with contents arranged by name

The printed view is a "snapshot" of the window's entire contents, showing
icons and information for folders and documents in their relative positions,
or a list of the items, in the same order that they appear in the window.

Choose Print Window from the File menu, then select the Options you want in
the Print dialog box and click Print.

The window's contents are printed in the format currently displayed,
including items not visible on the screen.

Keyboard shortcut for printing:  You can press Return or Enter instead of
clicking Print in the Print dialog box.

"Displaying a List of Items by Name, Size, Label, Kind, or Date" in Chapter 5

Printing while using the computer for other work

With the PrintMonitor program, you can print on a LaserWriter while
continuing to work with one or more programs. This feature is known as
background printing.

"Working With Several Open Programs" in Chapter 3

Preparing to use background printing.  To use background printing with a
LaserWriter, confirm that the PrintMonitor file is in the Extensions folder
(inside the System Folder) of your startup disk and that background printing
is turned on in the Chooser.

The PrintMonitor file is automatically placed in the Extensions folder when
you use the Installer's Easy Install option. If PrintMonitor has not been
installed, you can install it by dragging the PrintMonitor icon to the System
Folder icon (the Finder will automatically put PrintMonitor into the
Extensions folder). PrintMonitor is stored on the Printing disk supplied with
system software. 

Once background printing is turned on, it is in effect whenever you print
with a LaserWriter (until you turn it off).



After you choose the Print command and select options in the Print dialog
box, the printing status box appears on the screen for a few seconds, then
disappears. You can then continue other work. You may notice an occasional
pause while the Macintosh processes the document for printing.

Managing printing jobs.  You can control background printing with
PrintMonitor, a program supplied with the system software.

With PrintMonitor you can

- monitor the status of printing

- cancel a document currently printing or waiting to print

- set the time you want a document to print (date and hour) or postpone a job
indefinitely

- monitor paper supply (PrintMonitor's icon blinks at the right end of the
menu bar when the printer is out of paper; you can change the notification
method with the Preferences command in PrintMonitor's File menu.)

- be notified when you need to feed paper manually (PrintMonitor's icon
blinks at the right end of the menu bar to signal a manual print job; you can
change this notification with the Preferences command in the File menu.)

When background printing begins, PrintMonitor opens automatically and its
name and icon appear in the Application menu at the right end of the menu
bar.

You can choose PrintMonitor from the Application menu if you want to cancel a
printing job, check the status of printing (such as the number of pages still
to print), or postpone printing.

1.  After you have started printing a document, choose PrintMonitor from the
Application menu.

The PrintMonitor window opens. (PrintMonitor opens when background printing
is under way, or when you double-click its icon.)

2.  Select the options you want, then click the close box.

You can cancel printing of the current document or select one of the
documents waiting to print. (The Cancel button changes to Remove from List
when a waiting document is selected.)

"Working With Several Open Programs" in Chapter 3

Working with fonts

The Macintosh system software includes a selection of fonts --  collections
of letters, numbers, and symbols in a distinctive typographic design. You can
get more fonts from independent manufacturers, user groups, and computer
bulletin board services.

When you install Macintosh system software, a core set of fonts is installed
in the System file, which is inside the System Folder of your startup disk.
You can add other fonts or remove fonts. There are some additional fonts on
your Fonts disk.



Recognizing TrueType fonts and fixed-size fonts.  Two kinds of fonts are
supplied with the system software --  TrueType fonts (also called variable-
size fonts, outline fonts, or scalable fonts) and fixed-size fonts (also
called bitmapped fonts).

TrueType fonts describe all the characters of one font in one style, such as
Courier or Courier Bold. The Macintosh can display or print these characters
in any size. (TrueType fonts do not work with system software version 6.0.4
or earlier.)

Fixed-size fonts contain a set of characters of one size, such as 10-point
Geneva or 24-point Chicago. To see on screen or print high-quality characters
at different sizes, you need a font file for each size of character you want
to use.

You distinguish TrueType and fixed-size fonts by their icons.

When you open a font icon -- by double-clicking it -- a window displays a
sample of the font. 

Sample text in Times plain (TrueType) and New York 14 (fixed-size)

The Macintosh can use both fixed-size and TrueType fonts at the same time.
For example, you can have Times installed in your system as both a fixed-size
font and a TrueType font. When you select a font size, the Macintosh first
checks to see if there is a fixed-size font available. If there is no fixed-
size font available, the TrueType font is used.

If you have a TrueType font and a fixed-size font with similar names (such as
Courier Plain and Courier 12), and you want the Macintosh to use the TrueType
font, you need to remove the fixed-sized font from your System file. This
will produce a closer match between how type appears on screen and how it
appears when printed. However, any existing documents you've created with the
fixed-size fonts will be reformatted with the TrueType fonts, and line breaks
in these documents may change.

See also: "Using Fonts With Printers and Other Peripheral Devices" later in
this chapter

Installing a font.  You can easily install additional fonts.

1.  Quit all programs that are open.

You can't install a font when programs are open.

2.  Select the icon of the font you want to install and drag it to the System
Folder of your startup disk.

A dialog box appears, asking if the font should be placed inside the System
file.

3.  Click OK to complete the font installation.

Removing a font.  You remove a font by dragging its icon out of the System
file (inside the System Folder) of your startup disk.

1.  Open the System Folder of your startup disk by double-clicking its icon.



2.  Locate the System file double-click to open it.

3.  Locate the icon of the font you want to remove and drag that icon out of
the System Folder.

Be sure to drag the font out of both the System file window and the System
Folder window.

Using fonts with printers and other peripheral devices.  When you print with
a TrueType font, you automatically get the best possible print quality. If
you use fixed-size fonts, you may need to install several sizes to create
high-quality images with certain printers or other output devices (such as an
ImageWriter or a fax modem).

Consult the documentation supplied with your printer or other output device
to determine whether it has special requirements for using fixed-size fonts.

Transferring fonts to a LaserWriter printer

A LaserWriter can print a document more quickly if the fonts used in the
document are stored in the printer's memory or on a hard disk attached to the
printer. Some LaserWriter printers come with built-in fonts, which are stored
in the printer's read-only memory (ROM). You can transfer, or download,
additional fonts to the printer's random access memory (RAM) or to a hard
disk attached to the printer.

To download a font, you use the LaserWriter Font Utility, supplied on one of
the Tidbits disks. You can also use the LaserWriter Font Utility to:

- transfer PostScript files from your computer to a LaserWriter printer

- see a list of fonts available to a printer

- see a printed sample of fonts available to a printer

- initialize a hard disk attached to a printer

The dialog box for downloading fonts to a LaserWriter

"Turning the Printer's Sample Page On or Off" later in this chapter
"Transferring a PostScript File to a LaserWriter" later in this chapter

Downloading a font to the LaserWriter.  You can transfer fonts to a
LaserWriter printer with the LaserWriter Font Utility.

1.  Double-click to start the LaserWriter Font Utility.

The program is on one of the  Tidbits disks.

2.  Choose Download Fonts from the File menu.

3.  If the font you want to download is not listed, click the Add button to
add fonts to the list.

A directory dialog box appears, which you can use to locate the fonts you
want.

4.  Click the name of the font you want, then click Add.



You can Shift-click to select more than one font.

5.  When you've added all the fonts you want to download, click Done.

The directory dialog box closes and the fonts you added are listed in the
Font Utility dialog box.

6.  Click the Download button to send all the fonts in the list to the
printer or its hard disk.

When you click the Download button, a status box appears. You can click
Cancel to stop the process.

7.  Click OK when you see a message reporting the results of downloading.

Getting information about available fonts.  The LaserWriter Font Utility
provides three ways to see the fonts available to a LaserWriter. You can
display a list of fonts on the screen, print a catalog of fonts, or print a
set of font samples.

You choose a command from the program's File menu to get a font list or
samples.

The File menu commands for listing available fonts

Controlling LaserWriter operations

If your Macintosh uses a LaserWriter printer, you can control some printer
operations with the LaserWriter Font Utility, supplied with system software.
You can also use this program to transfer fonts and PostScript files to a
LaserWriter.

"Transferring Fonts to a LaserWriter Printer" earlier in this chapter

Turning the printer's sample page on or off.  The LaserWriter prints a sample
page each time it is turned on or restarted. You can turn the sample page on
and off with the LaserWriter Font Utility.

1.  Double-click to start the LaserWriter Font Utility.

The program is on one of the Tidbits disks.

2.  Choose Start Page Options from the Utilities menu.

3.  Click the On or Off button, then click OK to turn the sample page on or
off.

Restarting a LaserWriter printer.  You can use the LaserWriter Font Utility
to restart a LaserWriter printer.

1.  Double-click to start the LaserWriter Font Utility.

The program is on one of the Tidbits disks.

2.  Choose Restart Printer from the Utilities menu.

3.  Click Restart to restart the printer.



Click Cancel if you change your mind.

Transferring a PostScript file to a LaserWriter.  You can use the LaserWriter
Font Utility to transfer a file in PostScript format to a LaserWriter.
PostScript is a special language that describes the characters, symbols, and
images in a file to be printed or displayed.

1.  Double-click to start the LaserWriter Font Utility.

The program is on one of the Tidbits disks.

2.  Choose Download PostScript File from the Utilities menu.

3.  Double-click the name of the file you want to download to the printer.

When you double-click a file's name, a second directory dialog box appears in
which you name a file that saves a record of the PostScript activity. This
file has the preset name "PostScript Log."

4.  If you wish, type a new name for the log, then click Save.

The file is transferred to the printer and a record of the PostScript
activity is saved on your disk.

You can open the PostScript log to see the sequence of PostScript commands
when the file was transferred.

CHAPTER 5-ORGANIZING DOCUMENTS

The Macintosh desktop simulates an office filing system -- with icons
representing documents, folders, and even a Trash container. Other icons
represent application programs, disks, and other types of files.

The computer facilitates rapid handling of information, and Macintosh system
software provides a number of tools for storing and locating documents easily
and efficiently.

These include

- simple methods for naming documents and folders

- a visual filing system that's easy to move through

- commands to locate items by name or attributes

- directories of files displayed in the way you want

- easy display of important information about a document

Handling Documents

You use standard Macintosh operations to name and rename documents, copy
them, and move their icons. In addition, you can make duplicates of any
document.



Moving, copying and renaming a document.

Task                           Instruction
Example

Moving a                       Drag the icon of the document
document                       to the desired location.

Copying a document             Drag the icon of the onto another 
disk document to the icon of the destination 
disk (or an open window from that disk).

Copying a document            1.  Select the icon of the document to be
copied.

on the same disk              2.  Choose Duplicate from the File menu.
3.  If you wish, rename the document or drag it

to a new location.

Renaming a                    1.  Select the document's name 
document                          by clicking the name (not the icon).

2.  Type a new name.
3.  Click anywhere outside the icon.

Duplicating and copying shortcuts:  You can also use the keyboard shortcut
Command-D to duplicate a selected document. You can copy a document into
another folder (or onto the desktop) by holding down the Option key while you
drag the document's icon to the location you want. The new document's name
stays the same in this copying method.

Copying items while using the computer for other work.  When you're working
in the active window of an application program, you can copy files "in the
background" -- that is, while continuing to work in the program.

To use background copying, you simply switch from the program's active window
to the Finder and initiate the copying operation as usual. Once copying
begins, you can switch back to the application program and resume work as
your files are copied. You can't start a new application program while
copying is in progress, however.

Straightening up icons on the desktop or in a Finder window.  The Clean Up
command rearranges icons on the desktop or in a Finder window. This command
isn't available for windows displaying items in a list view.

The Clean Up command for a Finder window and for the desktop

Special cleanup options:  When cleaning up a window, holding down the Option
key sorts and arranges the icons alphabetically by name or using the list
view displayed most recently in that window. It also moves the icons to the
top left of the window. When cleaning up the desktop, holding down the Option
key lines up all icons at the right side of the screen. Holding down the
Shift key while choosing the Clean Up command cleans up the selected items
only.

"Using Special Keys and Indicators on the Keyboard" in Chapter 1
"Changing the Layout of Icons on the Desktop" in Chapter 7

Putting away items on the desktop.  A convenient way to use a program,
document, or folder is to drag its icon out of a Finder window onto the



desktop. Then the icon stays on the desktop until you remove the disk on
which the program, document, or folder actually is stored.

If you've placed an icon on the desktop, you can replace it in its original
location quickly and easily with the Put Away command.

1.  To put an item away, first select its icon.

2.  Choose Put Away from the File menu.

The selected item disappears from the desktop and is put back where it came
from. (You can make sure that the item has been put away by looking in its
original location.)

Using Folders to Organize Your Work

Like traditional filing systems, the Macintosh uses folders to store and
organize documents. You can easily place folders inside one another to create
multiple levels of files.

Three levels of folders and documents on a floppy disk

Whether you're using a hard disk or a floppy disk for your files, you can
establish an efficient filing system with folders.

Creating and naming folders.  You use the New Folder command to create a new
folder when you're working in the Finder.

1.  Choose New Folder from the File menu.

A new folder named "untitled folder" appears in the active window (or on the
desktop). The name is selected for editing.

2.  Type a name for the folder.

3.  Click anywhere outside the folder icon.

You can press Return after typing a name instead of clicking outside it; the
icon remains selected in this case.

Keyboard shortcut for folders:  You can also use the keyboard shortcut
Command-N to create a new folder.

New folders on the desktop and in a directory dialog box:  You can create a
folder directly on the desktop -- first click the desktop to make the desktop
active. Many programs allow you to create a new folder when you're using a
directory dialog box.

Summary:  Placing a document or a folder inside a folder.  You drag documents
or folders to place them in folders. 

Task                                  Instruction
Example

Placing a document           Drag the icon of document to 
in a folder                  the icon of the folder.



Placing a folder             Drag the icon of the folder 
inside another folder        to the icon of the folder you want 

to put it in.

You can store folders inside other folders -- called nesting folders -- to
create many levels of storage.

Using an alias for easy access to a file

The Macintosh system software can create an alias for a document, a folder, a
program, a disk, or even the Trash. An alias has the same icon as the
original file, and it is given the same name, with "alias" added at the end.
(You can change the name.) The name of an alias is displayed in italics,
except in the Apple menu.

An alias is not a copy of the original file; it is a tiny file (about 1-2K in
size) that points to the original. When you open an alias, the original file
actually opens. You can make any number of aliases for an original file.

Aliases help you get quick access to programs and files. You can have
multiple representatives of a document, folder, or program in various places
on your disk.

One alias is provided when the standard Macintosh system software is
installed -- an alias of the folder containing the control panels is placed
in the Apple menu for easy access. (The original Control Panels folder is in
the System Folder.)

Creating an alias.  Creating an alias is a simple procedure.

1.  Select the item for which you want to make an alias.

2.  Choose Make Alias from the File menu.

The alias appears next to the original. Its name is in italics and ends with
"alias." The name is selected for editing.

3.  If you wish, change the name of the alias, then move it to a new
location.

"Creating an Alias for a Program" in Chapter 3
"You Open an Alias and Nothing Happens" in Chapter 10
"Using Aliases to Connect Quickly" in Chapter 3 of the Macintosh Networking
Reference

Locating the original of an alias.  You can locate the original of an alias
by opening the alias's Info window.

1.  Select the icon of the alias whose original you want to find.

2.  Choose Get Info from the File menu.

The Get Info window appears.

3.  Click the Find Original button.

The window containing the original item opens; the icon of the original file
is highlighted.



If you move the original item, the alias will still find it. If you delete
the original, however, you'll see a message reporting that the original can't
be found. Aliases are not moved or deleted when the original files are moved
or deleted.

Keyboard shortcut for Info window:  You can use the keyboard shortcut
Command-I to display the Info window for any selected icon.

"Creating an Alias for a Program" in Chapter 3
"You Open an Alias and Nothing Happens" in Chapter 10

Locating Documents, Folders and Programs

Macintosh system software provides built-in searching for documents and
folders on any disk currently in use. The Find command lets you select
criteria for the item or items to be located. You can search all disks in
use, one disk, the contents of a window, or the current selection.

Finding items by name with the Find command.  When you choose the Find
command, it locates and displays the first item whose name contains the text
you supply. It searches all available disks.

A related command, Find Again, displays the next item meeting the criteria
you specified. You can use this command repeatedly to find all items
containing the search text; if no such item is found, you hear an alert
sound.

The Find command locates all items meeting the search criteria and displays
the first item. You can display each successive item found with the Find
Again command.

The Find command cannot locate items inside the System file (such as fonts
and sounds). You must open the System file to see its contents.

1.  Choose Find from the File menu.

The Find dialog box appears, with a blinking insertion point or with the text
you last entered, if you've used the command already. (If you used the
expanded Find dialog box recently, that dialog box appears. Click Fewer
Choices to return to the Find dialog box.)

2.  Type the text you want to search for.

You don't have to match uppercase and lowercase letters.

3.  Click the Find button to begin the search.

The search proceeds and the first item is displayed. If you hear the alert
sound, that means no items were found.

4.  If you don't see the item you want, choose Find Again from the File menu
to display the next item found.

If you hear the alert sound, that means all items have been displayed.

Keyboard shortcuts for Find and Find Again:  You can also use the keyboard
shortcuts Command-F to open the Find dialog box and Command-G to display the
next item found in a search.



Using other criteria for the Find command.  The expanded Find dialog box lets
you set criteria for searching your files.

The contents of the middle pop-up menu and the text area vary according to
the item selected in the left pop-up menu.

1.  Choose Find from the File menu.

The Find dialog box appears. (If you used the expanded Find dialog box
recently, that dialog box appears.)

2.  Click More Choices to display the expanded Find dialog box.

3.  Open the left pop-up menuto and choose the item for which you want to
search.

4.  Open the middle pop-up menu and choose the item you want.

5.  Adjust the date, choose an item, or enter the search text in the upper-
right area of the dialog box.

The item selected in the left pop-up menu determines what action you need to
take.

6.  Choose a search location from the pop-up menu labeled "Search."

You can choose to search all disks, a specific disk, the active Finder
window, or selected items.

7.  If you want all the items found to be displayed at once, click the
checkbox labeled "all at once."

8.  Click the Find button when you've finished selecting search criteria.

When search results are displayed one at a time, the first one is highlighted
and displayed on the screen at the end of the search. Each successive item
can be displayed with the Find Again command (in the File menu), or with the
keyboard shortcut Command-G.

Search results can also be displayed all at once. These results appear in a
list view.

Making a two-stage search with the Find command.  You can use two different
sets of criteria and locate one group of items that meet those criteria. To
do this, you make a two-stage search, like the one summarized in the steps
that follow.

1.  Establish the first set of criteria, making sure that you check the "all
at once" box in the expanded Find dialog box, then click Find.

Checking "all at once" displays results of the search in a list view; the
items that were found are highlighted.

2.  Choose the Find command again, before you click or take any other action.

You choose Find before taking any other action so the items located in the
first stage of the search remain highlighted.



3.  Set the second set of criteria, choose "the selected items" in the Search
pop-up menu, then click Find to begin the second stage of your search.

The search will be limited to the items found in the first stage, and only
those meeting both sets of criteria will be highlighted.

Special ways to use the Find command.  The Find command can help you locate
files quickly, organize large quantities of documents, and develop an
efficient system for backing up and archiving your work. Table 5-4 presents
some uses of the search criteria available with the Find command.

Sample uses of the Find command

Search criterion Can be used to locate

Name 1.  Files whose names you can't 
recall exactly

2.  All items for which you use a
standard name,such as status 
reports or expense reports

Kind                                      1.  All application programs
2.  All aliases

Size                                       Large files, to make space
available on a disk

Label                                     All the files to which you added
the same labe(such as "top secret")

Lock                                     Locked files, to unlock them for
editing

Modification date                        All files changed since a certain
date, for regular backup of new and
changed files

Creation date                            All files created before a certain
date, for archiving or erasing
outdated material

"Using a List View to See Several Levels of Files" later in this chapter

Moving Quickly Through Levels of Folders on a Disk

You can get quick access to other levels of folders on a disk from a pop-up
menu available in the active window on the desktop and in the directory
dialog box of an application program. In addition, the list view of a
window's contents provides access to items in any folder inside the window.

Moving through levels of folders with a pop-up menu.  You can use the pop-up
menu in a Finder window to move quickly to a higher level of your filing
system. To get access to the pop-up menu, hold down the x key while you press
the name of the active window. 

Choosing an item from the menu opens that window and makes it active.

1.  Hold down the x key, then open the pop-up menu by pointing to the window



title and holding down the mouse button.

2.  Drag the pointer to the name of the folder or disk that you want to open.

When you release the button, the corresponding window opens.

Closing a window while moving to a new level:  When you hold down the
Option key (as well as the x key) and choose a name from the pop-up menu, the
new window opens, and the window that was active closes.

When you're working in a program, the directory dialog box used to open or
save documents also has a pop-up menu that lets you open a different folder. 

You can also use a directory dialog box to change disks.

"Using a Directory Dialog Box" in Chapter 1

Using a list view to see several levels of fles.  When a window's contents
are displayed in a list view, you can move to any folder, document, or
program stored within the current window. You can also select items in
different folders simultaneously.

The list view lets you display the contents of a folder in the current window
and open items.

1.  Click the triangle next to a folder name to display the folder's
contents.

The folder's contents appear in an indented list.

2.  Double-click the icon of the item you want to open.

You may have to move through several levels of folders before locating the
document or program you want to open.

If you double-click a folder, it opens in a separate window, and its outline
view closes.

When you open a folder, document, or program by double-clicking its icon in
the outline view, its window becomes the active window.

Outline view shortcuts:  When a folder is selected in an outline view,
pressing Command-Right Arrow expands the folder (lists its contents) and
Command-Left Arrow collapses the list of folder contents. 

Using Folders Inside the System Folder

The Macintosh system software manages a number of special files that are
stored inside the System Folder of a startup disk. These include small
programs that give your system special functionality (these files are known
as system extensions and control panels), fonts, sounds, files of preferences
for application programs, and drivers for printers, scanners, and other
devices.

Because there can be many special files inside the System Folder, these files
are placed in folders named for the function they perform.(Some of the items
shown, such as the Clipboard file, appear only after you have used the
related command or desk acccessory.)



"Using an Alias for Easy Access to a File" earlier in this chapter
"Specifying Items to Be Opened at Startup" in Chapter 2
"Putting a Program or Its Alias in the Apple Menu" in Chapter 3
"Working With Desk Accessories" in Chapter 3
"Printing While Using the Computer for Other Work" in Chapter 4
"Working With Fonts" in Chapter 4
"Customizing the Apple Menu" in Chapter 7
"Getting Quick Access to Control Panels" in Chapter 7

Putting an item in the System Folder.  The System Folder is designed to
recognize the types of files it uses and to place those files in the
appropriate folders.

!!  IMPORTANT:  To take advantage of this capability, you must drag items to
the icon of the System Folder, not to the open window.

If you drag an item to the open System Folder window, the item moves into the
System Folder but is not placed in the special folder where it belongs. Some
items must be located in a special folder to work properly.    !!

If you are moving a document or an application program into the System
Folder, you need to open the System Folder and drag the item to the folder
you want to store it in (either Apple Menu Items or Startup Items).

1.  Drag the item to the icon of the System Folder on the startup disk.

2.  Read the message to confirm that the item will be placed where you want
it, then click OK.

To remove an item from the System Folder, you need to know where the item is
stored.

Removing an item from the System Folder.  If you don't know which folder
holds the item you want to remove, you can locate the item using the Find
command. (The Find command cannot locate items inside the System file,
however.)

1.  Double-click the icon of the System Folder to open it.

2.  Double-click the folder containing the item you want to remove.

3.  Drag the item out of the System Folder.

Be sure to drag the item both out of its special folder and out of the System
Folder.

See also: "Finding Items by Name With the Find Command" earlier in this
chapter

Getting Information About Documents and Disks

The Macintosh provides quick access to details about the documents and disks
it manages.

The View menu, which is always available when you're using the Finder, offers
several different ways to view the contents of a disk or folder. Two other
commands -- Get Info and About This Macintosh -- present details about
individual items.



Displaying a list of items by name, size, label, kind, or date.  Using the
View menu, you can display the contents of a window by icon or small icon, or
you can list them according to name, size, kind, date, or label.

The Macintosh system software is preset to show items by icon. This view is
useful when you want to move and select icons frequently.

A list arranged by name, size, kind of item, label, or date is useful when
one of those attributes is the key information you need about the items in
the window. For example, listing documents by the date and time of their most
recent modification makes backing up a large number of files an orderly task.

The list view's outline format also lets you select items in different
folders simultaneously.

Pull down the View menu and drag to choose one of the views available.

The list views are Name, Size, Kind, Label, and Date. You can add other views
by selecting them in the Views control panel.

See also: "Customizing How Icons and List Views Appear" in Chapter 7

Changing to a different list view.  When the contents of a window are
displayed as a list, you can change to another type of list view without
using the View menu. You simply click the type of view you want at the top of
the window.

Click the type of view you want to display at the top of the window.

The list is sorted when you release the mouse button.

"Customizing How Icons and List Views Appear" in Chapter 7

Getting information about a document.  The Get Info command displays
information about a single item on the desktop or in a Finder window.

1.  To get information,  first select the icon for which you want details.

2.  Choose Get Info from the File menu.

The Info window appears, displaying information about the selected icon.

3.  Click the close box to close the Info window when you're finished.

You can add comments to the Info window and later search for them with the
Find command.

Get Info shortcut:  You can use the keyboard shortcut Command-I to display
information about the selected item.

Other uses for the Info window:  You can also use the Info window to change
an icon, to turn a document into a stationery pad, and to lock a document
(prevent it from being changed or erased).

"Using Other Criteria for the Find Command" earlier in this chapter
"Creating Document Templates" in Chapter 3
"Protecting Information on a Disk" in Chapter 6"Changing the Appearance of
Icons" in Chapter 7



Getting information about an application program.  You can use the Get Info
command in the File menu to get information about an application program.

1.  Select the icon of the program about which you want information.

2.  Choose Get Info from File menu.

The Info window opens.

3.  Click the close box to 3 close the Info window when you're finished.

You can use the Info window to adjust the memory allocated for a program and
to lock the program (which prevents it from being thrown away).

"Changing the Amount of Memory a Program Uses" in Chapter 3
"Protecting Information on a Disk" in Chapter 6
"Changing the Appearance of Icons" in Chapter 7

Getting information about your Macintosh.  When you're working in the Finder,
the About This Macintosh command in the Apple menu displays information about
your Macintosh, including memory usage.

1.  Choose About This Macintosh from the Apple menu when you're working in
the Finder.

2.  Click the close box to close the About This Macintosh window when you're
finished.

See also: "Managing System Memory" in Chapter 3

Taking a "Snapshot of the Screen

The Macintosh system software can take an image of the screen's content. The
image is created as a PICT file, which can be used with a variety of programs
that handle graphics. The TeachText program, supplied with the system
software, can also open these files.

The files are named "Picture 1," "Picture 2," and so on. (The number of
screen images you can take is limited only by available disk space.)

Taking a screen snapshot.  You use a keystroke combination to take a picture
of the screen.

Hold down the Command, Shift, and number 3 keys simultaneously.

You hear a click and a new icon appears in the window of the startup disk.

Viewing a screen snapshot with TeachText.  You open a screen image the usual
way with TeachText.

Double-click the icon of the screen image you want to open.

You can also drag to select a portion of a PICT file displayed in TeachText
and then copy that selection to the Scrapbook or to another document. The
size of the selection you can copy in TeachText depends on the amount of
memory you allocate to the program.

Other ways to work with screen images:  You can open a screen image with any



program that can work with the PICT format by dragging the icon of the
document to the icon of the program, or by opening the document from within
the program.

"Changing the Amount of Memory a Program Uses" in Chapter 3

CHAPTER 6-MANAGING DISKS AND DISK DRIVES

Disks are the Macintosh computer's principal storage medium. Every Macintosh
model has at least one internal floppy disk drive, and most models offer an
internal hard disk as well.

The system software and most applications are supplied on 3.5-inch floppy
disks, which are ideal for transporting data and backing up important work.

Hard disks offer the advantages of large storage capacity and speed of
operation, although they are not as easily transported as floppy disks.

Using floppy disks

The floppy disks used in a Macintosh are flexible plastic disks (the source
of the name "floppy") inside a hard plastic case 3.5 inches wide. A metal
shutter at one end of the disk slides to one side when the disk is in the
drive, exposing the flexible plastic on which information is stored. The
plastic is coated with a magnetic layer, similar to the recording tape in
tape cassettes.

Disk capacities.  The amount of information a floppy disk can store depends
on the type of disk drive in which it is used and on the way the disk is
initialized -- that is, the way its magnetic surface is electronically
prepared to store data.

Macintosh disks have one of three capacities:

- 400 kilobytes (K)

- 800K

- 1.4 megabytes (MB)

Consult the Special Features booklet or other documentation that came with
your computer to learn more about the floppy disks your Macintosh can use.

High-density disks and SuperDrive.  Disks with a capacity of 1.4 MB are high-
density disks and can be used in the Apple SuperDrive high-density disk
drive. High-density disks usually have the letters "HD" on their case or
metal shutter. High-density disks also have an extra hole in the plastic case
(on the opposite side from the disk-locking tab), which allows the SuperDrive
to recognize them.

!!  IMPORTANT:  Use high-density disks in the SuperDrive only. You cannot use
these disks in drives that accept only 800K or 400K disks. !!

The SuperDrive accepts all three types of floppy disks -- 400K, 800K, and 1.4
MB. This disk drive can also read 3.5-inch disks from computers that use the
MS-DOS operating system.



"Locking a Floppy Disk" later in this chapter 
"Floppy Disks and Drives" in Chapter 9 Appendix C, 
"Exchanging Disks and Files With MS-DOS Computers"

Inserting a floppy disk.  Hold the disk metal end first and label side up,
and slide it into the disk drive.

The disk snaps into place and its icon appears on the screen or a dialog box
reports that the disk is unreadable.

"Preparing and Naming a New Floppy Disk" later in this chapter"Testing and
Repairing a Disk" in Chapter 9

Ejecting a disk from the desktop.  You can easily eject a floppy disk and
remove its icon from the desktop. This method also works for ejecting a CD-
ROM disc or disconnecting from a shared disk on the network.

1.  Select the icon of the disk you want to eject.

2.  Choose Put Away from the File menu.

The disk is ejected and its icon disappears from the desktop.

Shortcut for ejecting a disk:  You can also eject a disk by dragging its icon
to the Trash icon. (Dragging a disk to the Trash does not erase the disk's
contents.).

Method                                            Result

Selecting the disk icon and            Disk is ejected; icon disappears
choosing Put Away from the
File menu (shortcut: Command-Y)

Dragging the disk icon to the          Disk is ejected; icon disappears
Trash

Selecting the disk icon and             Disk is ejected; dimmed icon 
choosing Eject Disk from the            stays on the desktop 
Special menu (shortcut: Command-E)

"Preparing and Naming a New Floppy Disk" later in this chapter
"Testing and Repairing a Disk" in Chapter 9
"You Can't Eject a Floppy Disk" in Chapter 10

Ejecting a disk from within a program.  You can eject a disk when you're
working in a program by using a command, such as Open or Save As, that
displays a directory dialog box.

1.  With the directory dialog box displayed, click the Desktop button to
locate the disk you want to eject.

Skip this step if the disk named in the box is the one you want.

2.  Click the name of the disk you want to eject.

The Eject button becomes available when a floppy disk or CD-ROM disc is
selected.



3.  Click the Eject button to eject the selected disk.

The disk is ejected. Its dimmed icon stays on the desktop.

"Preparing and Naming a New Floppy Disk" (next section)"Testing and Repairing
a Disk" in Chapter 9"You Can't Eject a Floppy Disk" in Chapter 10

Preparing and naming a new floppy disk.  When you want to use a brand-new
disk, you need to prepare it to receive information. This process is called
initialization, or formatting. If a disk already contains data, initializing
it erases that data.

You name a disk when you initialize it.

!!  WARNING:  Be sure that any disk you plan to initialize contains no
information you want to save, because you'll lose that information during
initialization.  !!

1.  After placing a new 1 disk in the disk drive, click Initialize (for a
high-density disk), Two-Sided (for an 800K disk), or One-Sided (for a 400K
disk).

If the disk has been used with another type of computer, the message will
tell you that the disk is not a Macintosh disk.

2.  Click the Erase button to continue initialization.

You can click Cancel to avoid erasing the disk.

3.  Type the name you 3 want for the disk and click OK.

Initialization proceeds, and the disk icon appears on the desktop.

If you don't name the disk, it will have the name "Untitled." You can rename
the disk by clicking its name and typing a new one.

Appendix C, "Exchanging Disks and Files With MS-DOS Computers"

Erasing a disk.  To erase an already initialized disk, use the Erase Disk
command in the Special menu. This command actually reinitializes the disk.

1.  Select the icon of the disk you want to erase.

2.  Choose Erase Disk from the Special menu.

A message appears, asking you to confirm the action. If you're erasing a
normal-density disk, you need to select the capacity of the disk.

3.  Click Initialize or click the button for the disk capacity you want.

The disk is erased and reinitialized. Its name stays the same.

Renaming a disk.  You can easily rename a disk, just as you would rename any
icon on the desktop.

1.  Click the name (not the icon) of the disk you want to rename.

A box appears around the name and the text is selected.



2.  Type a new name for the disk.

The insertion point blinks at the end of the text you type.

3.  Click anywhere outside the disk icon.

When you click, the new name is saved and the icon is no longer selected.

Making a backup copy of a disk.  Although floppy disks are designed to last
through thousands of hours of use, they can become damaged or worn. So it's
wise to make backup copies of important work and application programs.

You can make backup copies of individual documents as necessary. You should
also back up such essential disks as startup disks, system software master
disks, and program master disks.

1.  To make a backup copy, first point to the icon of the floppy disk you
want to back up (the source disk).

2.  Drag the icon of the floppy disk you want to back up to the icon of the
disk on which the copy will be made (the destination disk).

The destination disk can be a floppy disk (as pictured) or a hard disk. If
the destination disk is a floppy disk, a message appears.

3.  Read the message to make sure you're making the correct decision, then
click OK to begin the backup procedure.

If you click Cancel rather than OK, no backup takes place.

See also: "Preparing and Naming a New Floppy Disk" earlier in this
chapter"Backing Up the Information on a Hard Disk" later in this chapter

Using a hard disk

A hard disk drive consists of metal disks permanently sealed inside a drive
compartment. The drive's sealed environment permits extremely fast reading
and writing of information, and the multiple disks inside a drive store 20 to
160 megabytes of information, or even more.

Hard disk precautions.  Because the components inside a hard disk drive are
very close together and moving very fast when the drive is turned on, these
drives should be handled with care.

Observe these precautions when working with a hard disk:

- Avoid jostling or rough handling of the drive (and of any Macintosh with an
internal hard disk). Never move a Macintosh when the internal hard disk drive
is operating.

- Some Macintosh computers are designed to operate either sitting flat or
turned on one side. The setup guide that came with your Macintosh includes
special instructions if your model can be placed on its side. Do not place
the computer on its side unless it is designed to operate this way; doing so
could damage the hard disk.

- Always keep the drive on a sturdy, level surface.



- Operate a hard disk at temperatures between 50 and 104 degrees Fahrenheit
and at a relative humidity of 20 to 80 percent.

- Avoid spilling any liquids on or near the drive.

- Do not expose the drive to hazardous vapors, such as those from cleaning
solvents.

Preparing a new hard disk.  You use the Apple HD SC Setup program, supplied
with your system software (on the Disk Tools disk), to prepare a new hard
disk. Apple HD SC Setup lets you initialize the disk (prepare it to store
information) and give it a name.

The internal hard disks in many Macintosh models are prepared at the factory;
these hard disks do not have to be initialized again. If the disk in your
computer has been initialized, you'll see the disk's icon on the desktop when
you first turn on the computer. 

!!  WARNING:  If you received a hard disk with the A/UX operating system on
it, do not initialize that disk; doing so will erase A/UX. Instead, see your
A/UX documentation for instructions.  !!

1.  To initialize a hard disk, start Apple HD SC Setup by double-clicking its
icon.

A dialog box appears.

2.  If the disk you want is not shown, click the Drive button to select the
disk you want to initialize.

The SCSI ID number of the selected hard disk is displayed above the Drive
button. The ID number of an internal hard disk is 0. The ID number of an
Apple external hard disk is preset to 5.

3.  When the number (and name, if any) of the hard disk you want is
displayed, click Initialize to begin.

A message appears asking you to confirm your decision.

4.  Click Init to initialize the hard disk.

Messages report the status of initialization. (If you see a message that
initialization has failed, try again. If initialization fails a second time,
see your authorized Apple service provider.)

5.  Type a name for the hard disk, then click OK.

If the disk has been initialized previously, this dialog box does not appear.

6.  Click Quit when the message reports that initialization was successful.

"Setting the SCSI ID Number" in Chapter 8
"Testing and Repairing a Disk" in Chapter 9

Erasing a hard disk.  You can erase a hard disk using the Erase Disk command.
This command reinitializes the disk.

1.  To erase a hard disk, first select the icon of the disk you want to



erase.

2.  Choose Erase Disk from the Special menu.

A message appears, asking you to confirm that you want to initialize the
disk.

3.  Click the Initialize button.

Clicking Cancel stops the procedure.

Renaming a hard disk.  You rename a hard disk just as you do any icon on the
desktop.

1.  Click the name (not the icon) of the hard disk you want to rename.

A box appears around the name when it's selected.

2.  Type a new name for the disk.

The insertion point blinks at the end of the text you type.

3.  Click anywhere outside the disk icon.

The new name is saved, and the icon is no longer selected.

!!  IMPORTANT:  You can't rename a hard disk that is being used for file
sharing.  !!

Backing up the information on a hard disk.  You can back up the work you
store on a hard disk by copying individual files in the usual way (dragging
their icons to the icon of another disk).

You can also use a commercial backup program to copy some or all files from a
hard disk to another hard disk, to a tape drive, or to a series of floppy
disks.

Whatever method you use, be sure to back up important files and programs on
your hard disk regularly.

"Making a Backup Copy of a Disk" earlier in this chapter
"Backing Up the Session's Work" in Chapter 3

Startup disk sequence

When you start up your Macintosh, it looks in attached disk drives for a
startup disk (a disk containing a System Folder). The Macintosh looks at the
disk drives in order. This is called the scanning order. The computer always
looks first in the floppy disk drives, then it looks at external and internal
hard disks.

You can specify which hard disk the Macintosh checks first by using the
Startup Disk control panel.

The scanning order for a startup disk.  The Macintosh scans disk drives for a
startup disk in the following order:

- internal floppy disk drive



- second internal floppy disk drive (if any)

- external floppy disk drive (if any)

- hard disk selected in the Startup Disk control panel

- internal SCSI hard disk (the computer waits a few seconds for the internal
drive to warm up)

- external SCSI hard disk (if there is more than one, it looks first at the
hard disk with highest SCSI ID number, and so on in descending order)

- internal hard disk (the computer returns to this drive and waits another
few seconds)

If no startup disk is found, the computer displays a blinking question mark
on a floppy disk icon and waits for a startup disk to be inserted in a floppy
disk drive.

If you use one or more external hard disks with your Macintosh, you need to
turn those drives on a few seconds before you turn on the computer; otherwise
the computer will not recognize them.

"Specifying Items to Be Opened at Startup" in Chapter 2
"Setting the SCSI ID Number" in Chapter 8

Designating a startup disk.  If you use more than one hard disk with your
Macintosh, you'll save time during startup if you specify which one is the
startup disk. You use the Startup Disk control panel for this task. 

When you designate a startup disk, the computer looks at that hard disk first
for a System Folder, and uses that System Folder to start up.

1.  Double-click the icon of the Startup Disk control panel to open it.

It's located in the Control Panels folder, which you can open from the Apple
menu.

2.  Click the icon of the disk you want to use as the startup disk.

It's a good idea to close the control panel when you're finished.

The next time you start up the computer, it uses the hard disk you specified
as the startup disk, if that disk contains a System Folder and if no floppy
disk with a System Folder is inserted. If the hard disk does not contain a
working System Folder, the Macintosh goes on to check other hard disk drives,
if any are attached.

Skipping the internal hard disk at startup: You can skip the internal hard
disk in your Macintosh at startup by pressing Command-Option-Shift-Delete
when the computer starts up.

Protecting information on a disk

You can protect all the information on a floppy disk by locking the disk
itself, or you can lock individual documents and application programs in
their Info windows.



The information in a locked document or on a locked disk can't be changed or
thrown away; it can usually be opened or copied, however.

Locking a floppy disk.  You adjust a tab on the disk's plastic case to lock
it.

To lock a oppy disk, slide the tab toward the edge of the disk with the tip
of a ballpoint pen (or your finger).

The disk is locked when the tab snaps into position and you can see through
the hole in the disk's case.

Sliding the tab away from the disk's edge (covering the opening in the case)
unlocks a floppy disk.

Locking a document or program.  You use the Get Info command to lock a
document or lock a program.

1.  To lock an item, first select its icon.

2.  Choose Get Info from the file menu.

The Info window opens.

3.  Click the Locked box in the lower-left corner.

4.  Click the close box to close the Info window.

The item is now locked.

Deleting a locked item:  You can delete a locked item by dragging it to the
Trash, then holding down the Option key while choosing the Empty Trash
command from the Special menu.

Locking a program may affect its operation.

Locking folders:  You can't use Get Info to lock folders; however, you can
lock the items in a folder, and you can protect the contents of folders
you're sharing on a network.

Locking an alias:  You can lock an alias, but that does not lock the original
file. It just prevents the alias from being thrown away accidentally.

"Reducing Access to Your Macintosh" in Chapter 4 of the Macintosh Networking
Reference
"Access Privileges," Chapter 5 of the Macintosh Networking Reference

CHAPTER 7-CUSTOMIZING YOUR MACINTOSH

The Macintosh is designed to let you adjust some aspects of its operation and
its screen's appearance. You can customize such things as

- mouse operation

- keyboard operation



- sound and volume

- time and date

- the look of the desktop

- colors or shades of gray displayed on your monitor

- fonts and sounds used in the system

Most of these adjustments are made using control panels. Some use desk
accessories or other parts of the system software supplied with the
Macintosh. Screen brightness is adjusted with the hardware on some models of
the Macintosh.

As you make adjustments in the control panels and other parts of system
software, keep in mind that you can get on-screen descriptions of the
windows, icons, menu items, and dialog boxes by turning on the balloons in
the Help menu.

"Turning Balloon Help On and Off" in Chapter 1

Customizing the Apple menu

The Apple menu provides quick access to files that you use frequently --
programs, desk accessories, documents, folders, and even aliases for disks or
file servers. You can add any number of items to this menu, and you can
easily remove items from it.

When you install the system software, the Alarm Clock, Calculator, Chooser,
Control Panels folder, Key Caps, Note Pad, Puzzle, and Scrapbook are placed
in the Apple menu. If your model of the Macintosh has a special desk
accessory (such as the Battery for the Macintosh Portable), this may also be
placed in the Apple menu when you install the system software.

Once an item is in the Apple menu, you simply choose its name from that menu
to open it.

See also: "Using an Alias for Easy Access to a File" in Chapter 5

Adding items to the Apple menu.  You add items to the Apple menu by dragging
their icons to the Apple Menu Items folder, which is stored inside the System
Folder of your startup disk.

Drag the items you want to add to the Apple Menu Items folder (inside the
System Folder).

The items are added to the menu immediately.

You can confirm that the items have been added by pulling down the Apple
menu.

To remove items from the Apple menu, drag their icons out of the Apple Menu
Items folder.

Apple menu shortcut:  If you frequently add items to or remove items from the
Apple menu, you can get at the Apple Menu Items folder more quickly if you
create an alias for the folder and place it on the desktop.



Using control panels

Several control panels are provided with the system software. Each control
panel lets you customize one part of your system.

Getting quick access to control panels.  An alias for the Control Panels
folder is placed in the Apple menu when system software is installed. If you
use a control panel frequently and want even speedier access to it, you can
make an alias for that individual control panel and place the alias on the
desktop, in the Apple menu, or in another convenient place.

!!  IMPORTANT:  To avoid problems with the control panels, be sure to leave
the original control panels in the System Folder, inside the Control Panels
folder.  !!

You open a control panel by choosing Control Panels from the Apple menu and
then double-clicking the control panel's icon or by selecting the icon and
choosing Open from the File menu.

"Adding Items to the Apple Menu" earlier in this chapter
"Using Control Panels" in Chapter 1
"Putting a Program or Its Alias in the Apple Menu" in Chapter 3
"Using an Alias for Easy Access to a File" in Chapter 5
"Selecting a Network Connection" in Chapter 2 of the Macintosh Networking
Reference
"Monitoring File Sharing Activity" in Chapter 4 of the Macintosh Networking
Reference

Adjusting mouse operation

You can modify two aspects of mouse operation -- pointer movement and double-
clicking speed -- in the Mouse control panel. 

Adjusting the speed of pointer movement.  The correlation between mouse and
pointer movement, called mouse tracking, can be adjusted so that the pointer
moves the same distance on the screen as the mouse moves, or so that the
pointer moves farther on the screen than the mouse moves, depending on how
fast you move the mouse.

Mouse tracking is preset to a medium speed when you install the system
software. The options for tracking are:

- Slow -- the mouse and the pointer move approximately the same distance

- Fast -- the pointer moves more than twice as far as the mouse

- Buttons between Slow and Fast -- gradations between the slow and fast
speeds

- Very Slow/Tablet -- the pointer moves at a constant speed when the mouse is
moved, a useful setting for drawing with the mouse or using a graphics tablet

To adjust mouse tracking, choose Control Panels from the Apple menu and then
double-click the Mouse control panel to open it.

Click the button for the tracking option you want.

The new tracking option takes effect immediately; you can test it by moving



the mouse.

Your choice remains in effect until you choose a different tracking option.

Setting the double-clicking speed.  You can adjust the double-clicking speed
of the mouse button. You'll probably want to do this if you find that the
computer often interprets two clicks as a double click, or a double click as
two single clicks.

To adjust the double-clicking speed, choose Control Panels from the Apple
menu and then double-click the Mouse control panel to open it.

Click the double-clicking speed you want.

When you click, the mouse button on the screen is highlighted twice at the
interval you selected.

If the Macintosh tends to interpret two clicks as a double click, choose a
faster speed. If it interprets a double click as two single clicks, choose a
slower speed.

Your choice remains in effect until you choose a different double-clicking
speed.

Adjusting keyboard operation

You can adjust the rate at which a character repeats when its key is held
down as well as the delay before the character begins repeating. You can also
change the keyboard layout.

You make these adjustments in the Keyboard control panel.

Setting the speed at which a key repeats.  On all Macintosh keyboards,
holding down a key causes the character to appear repeatedly on the screen
until you release the key. (This isn't true for all keys.) You can adjust the
rate of repetition.

To adjust the speed at which a key repeats, choose Control Panels from the
Apple menu and then double-click the Keyboard control panel to open it.

Click the button for the repeat rate you want.

After you close the control panel, your choice remains in effect until you
choose a different key repeat rate.

Setting the delay before characters repeat.  You can adjust the keyboard's
sensitivity to your "touch" by setting the delay before a character begins
repeating when a key is held down. If you find that characters repeat when
you don't want them to, you should adjust the keyboard's sensitivity.

To adjust the delay before keys repeat, choose Control Panels from the Apple
menu and then double-click the Keyboard control panel to open it.

Click the button for the repeat delay you want.

Clicking the Off button turns off the character-repeat feature.

Your choice remains in effect until you choose a different delay option.



Changing keyboard layout.  To change the keyboard layout, choose Control
Panels from the Apple menu and then double-click the Keyboard control panel
to open it. (Your Macintosh may have only one choice in the Keyboard Layout
section of this control panel, depending on where you purchased it.)

Click the name of the keyboard layout you want to use.

Your choice remains in effect until you choose a different key layout.

Adjusting sound and volume

You can adjust the computer's speaker volume and change the alert sound for
your Macintosh, and you can also add or remove alert sounds.

You use the Sound control panel to set the speaker volume and to choose the
sound the Macintosh makes when it signals you.

Setting the speaker volume.  You can choose one of eight volume settings for
the Macintosh computer's built-in speaker. To adjust the volume, choose
Control Panels from the Apple menu and then double-click the Sound control
panel to open it.

Drag the bar to set the speaker volume.

When you release the mouse button, the alert sound plays at the volume you
selected.

When you set the volume at zero, the menu bar flashes in place of an alert
sound.

Your choice remains in effect until you choose a different speaker volume.

See also: "Setting the Alert Sound" (next section)

Setting the alert sound.  Many programs are designed to play a sound when an
alert message is displayed or when you try to give a command that the program
does not recognize. You can choose one of several options for the alert
sound.

To set the alert sound, choose Control Panels from the Apple menu and then
double-click the Sound control panel to open it.

Click the name of the sound you want.

The sound plays when you click it.

Your choice remains in effect until you choose a different alert sound.

Flash instead of sound:  When the speaker volume is set to zero, the menu bar
flashes in place of an alert sound.

See also: "Setting the Speaker Volume" (previous section)

Installing a sound.  The Macintosh has a set of standard sounds. You select
one of these to be your alert sound using the Sound control panel. You can
get additional sounds from various sources. To install a sound, you add it to
the System file inside the System Folder.



You can recognize a sound by its special icon. 

Once you add a sound to the System file, it is listed in the Sound control
panel.

1.  Select the sound you want to install and drag it to the System Folder of
your startup disk.

A dialog box appears, asking if the sound should be placed inside the System
file.

2.  Click OK to complete the sound installation.

Remvoing a sound.  You remove a sound by dragging its icon out of the System
file (inside the System Folder) of your startup disk.

1.  Open the System Folder of your startup disk by double-clicking its icon.

2.  Locate the System file icon and double-click to open it.

3.  Locate the sound you want to remove and drag it out of the System file.

You can hear a sound by double-clicking its icon.

Recording sounds

Some Macintosh computers come with a sound input port, to which you can
connect either a microphone (to record sounds that you create) or a phono
jack adapter (to record sounds from another audio source such as a compact
disc or a tape cassette). All Macintosh computers can accept sound input, but
with some you need to purchase special equipment to record sounds.

Recording a system sound.  One way you can experiment with your computer's
sound input capability--without purchasing additional software--is by adding
a new system sound. To add a new sound, connect the microphone to your
computer as described in the setup guide that came with your computer. Then
choose Control Panels from the Apple menu and double-click the Sound control
panel to open it.

1.  Click the icon that represents the sound input device you want to use.

If you have only one sound input device connected to your computer, it's
already selected and you can skip this step.

2.  Click the Add button.

The Record dialog box appears.

3.  To record your new sound, click the Record button.

Recording begins immediately; you have ten seconds to record your sound. To
adjust the volume of the recorded sound, you can make the sound louder or
softer, or you can move the microphone.

4.  Click Stop to stop recording.

5.  To listen to the sound you just recorded, click Play.



6.  To save the sound you just recorded, click Save.

A dialog box appears that lets you name your new sound.

7.  Type a name for your sound, and click OK.

Your new sound is stored in the System file. Its name appears in the Sound
control panel.

When you're finished recording new sounds, close the Sound control panel.

Setting time and date

The Macintosh has an internal clock that runs continuously. A battery inside
the computer maintains the time and date when the machine is turned off.

You can set the time and date in the General Controls panel (or in the Alarm
Clock desk accessory). 

"Setting an Alert Time With the Alarm Clock" later in this chapter
"Changing the Clock Battery" in Chapter 9

Changing the time or date.  You change the time or date in the General
Controls panel. When setting the time, you can specify a 12-hour clock
(showing a.m. and p.m. with the time) or a 24-hour clock.

To adjust the time or date, you choose Control Panels from the Apple menu and
then double-click the General Controls panel to open it.

1.  If you want to change the type of clock selected (12-hour or 24-hour),
click the appropriate button.

2.  Click the part of the time or date you want to change (hours, minutes,
seconds, AM or PM, month, day, or year).

The part of the time or date you click becomes highlighted, and small up and
down arrows appear at the right.

3.  Click repeatedly on the up or down arrow until the time or date you want
is displayed.

You can also type a new number.

4.  To save the new time or date, click the clock icon (for time) or the
calendar icon (for date).

The icon becomes highlighted briefly, then the new time or date is displayed.

The time or date you set remains in effect until you change it.

Another way to set the time or date:  You can also set the time or date, as
well as an alert time, in the Alarm Clock, a desk accessory that is part of
the system software supplied with the Macintosh.

Setting an alert time with the Alarm Clock.  You can set the Alarm Clock desk
accessory to alert you at a predetermined time. The Alarm Clock is part of
the system software and is placed in the Apple menu when you install the
system software.



You open the Alarm Clock by choosing it from the Apple menu.

1.  Click the upward-pointing lever to the right of the time to expand the
Alarm Clock.

The lever points down, and the Alarm Clock expands to its full size.

2.  Click the alarm clock icon in the lower right to select it.

The alarm clock is highlighted when you select it. The time that appears in
the middle is the current alarm setting.

3.  Click the button to the left of the time in the middle section to turn
the alarm on.

When you click, the alarm clock icon changes to indicate that the alarm is
turned on. (Clicking again turns the alarm off.)

4.  Click the part of the time you want to change.

The part of the time selected becomes highlighted, and small arrows appear.

5.  Click the up or down arrow repeatedly until the time you want is
displayed.

Or you can type the number you want.

6.  Click the close box to close the Alarm Clock.

The alarm will not go off unless you click the lever to return to the compact
clock, select another area of the clock, click the close box, or make another
window active.

When the system clock reaches the time set for the alarm, the alert sound
plays (the menu bar flashes once if the speaker volume is set to zero) and an
alarm clock icon alternates with the Apple icon at the left side of the menu
bar.

You need to open the Alarm Clock to stop the alarm clock icon blinking in the
menu bar.

Setting the time and date:  You can also set the system clock's time and
date in the Alarm Clock desk accessory, by first selecting the time or date
icon and then changing the numbers.

Changing the look of the desktop

You can modify the desktop's appearance with several different control
panels.

You adjust three of these items -- the desktop pattern, blinking of a chosen
menu item, and blinking of the insertion point -- in the General Controls
panel.

Changing the pattern displayed on the desktop.  You can choose from a variety
of patterns provided for the Macintosh desktop, or you can create your own
design by editing one of the patterns supplied. If your Macintosh can display
colors or shades of gray, you can also select your own colors to use in the



desktop pattern.

To adjust the desktop pattern, choose Control Panels from the Apple menu and
then double-click the General Controls panel to open it.

1.  To see the patterns available, click one of the small triangles at the
top of the miniature desktop.

The pattern changes each time you click.

2.  When you see a pattern you like, click the miniature desktop to see the
new pattern on your desktop.

The new pattern replaces the current pattern for the desktop.

3.  To edit a pattern, click in the pattern-editing area.

Each square changes color when clicked. Your changes are displayed in the
miniature desktop.

4.  To edit with another 4 color, select it in the color bar, then click the
squares you want to change.

5.  When you've finished editing, click in the miniature desktop to display
the new pattern on the desktop.

By double-clicking in the miniature desktop, you can save the new pattern.
Otherwise it is lost when you display another pattern in the miniature
desktop.

The desktop pattern remains in effect until you change it.

Changing a color in the desktop pattern:  You can also change the color of
an existing pattern by double-clicking a color in the color bar and choosing
a new color from the color wheel dialog box (in the same manner as you change
the highlight color).

"Changing the Highlight Color" later in this chapter
"Coloring Icons" later in this chapter
"Changing the Colors in the Label Menu" later in this chapter

Adjusting the blinking of a menu item.  Menu items are preset to blink three
times when you choose them. You can change the number of times a menu item
blinks using the General Controls panel. (See Figure 7-7.)

To adjust menu blinking, choose Control Panels from the Apple menu and then
double-click the General Controls panel to open it.

Click the button for the number of times you want the menu item to blink.

Clicking the Off button prevents a menu item from blinking.

The menu-blinking option you selected remains in effect until you change it.

Adjusting the blinking of the insertion point.  The insertion point is used
to designate the place in a document or an icon name where new material will
be inserted. You can change the blinking rate of the insertion point in the
General Controls panel. 



To adjust the blinking of the insertion point, choose Control Panels from the
Apple menu and then double-click the General Controls panel to open it.

Click the button for the rate of blinking you want.

When you click, the example insertion point shows the rate of blinking you
selected.

The option you selected remains in effect until you change it.

Customing how icons and list views appear

The Views control panel lets you designate how icons are displayed on the
desktop and what information list views contain. You can also change the font
used for icon names and list views.

Changing the font for list views and icon names.  You use the Views control
panel to change the font and size used in the Finder for icon names and
information. You open the Views control panel by choosing Control Panels from
the Apple menu and then double-clicking the Views icon.

1.  Choose a font from the pop-up menu.

2.  Choose a font size from the pop-up menu.

You can also type a number for the font size. Numbers displayed in outline
form indicate the sizes that look best.

Your changes take effect immediately.

Changing the layout of icons on the desktop.  You change the layout of icons
in the Finder in the Views control panel, which you open by choosing Control
Panels in the Apple menu and then double-clicking the Views icon. 

Icons are arranged along an invisible grid of horizontal and vertical lines
on the desktop or in a window. You can designate whether the icons should
always line up along the grid when you move them (the "always snap to grid"
option), and you can specify whether icons are displayed in straight rows
(straight grid) or in offset rows (staggered grid).

Click the options you want for the layout of icons.

Your changes take effect the next time you use the Clean Up command.

"Straightening Up Icons on the Desktop or in a Finder Window" in Chapter 5

Changing the information or icon size dsiplayed in list views.  You change
the information and size of icons displayed in list views (such as View by
Name or View by Date) in the Views control panel, which you open by choosing
Control Panels from the Apple menu and then double-clicking the Views icon. 

Click the kinds of information and size of icons you want displayed in list
views.

The information you select will appear in all Finder windows that display
items in a list (rather than by icon or by small icon). The "Show" options
you select will also appear as commands in the View menu.



Your changes take effect immediately.

Changing the appearance of icons

The Macintosh system software lets you customize icons by changing the look
of the icon itself, and by adding labels to icons. If your Macintosh displays
color or shades of gray, the label can be both a word and a color. If your
system displays only black and white, you can add word labels.

After you label icons, you can use the View menu to group similar types of
items by label.

"Coloring Icons" later in this chapter
"Changing the Colors in the Label Menu" later in this chapter

Changing the look of an icon.  You can invent your own icons by changing the
look of existing icons. You can use a graphics program to create and copy the
picture you want, and then paste it into the icon's Info window. 

Some icons can't be customized, including those for locked items, control
panels, and other parts of the system software.

1.  In a graphics program, select the picture you want to use for the icon.

2.  Copy the picture by choosing Copy from the Edit menu.

3.  Switch to the Finder, then click to select the icon you want to change.

4.  Choose Get Info from the File menu.

5.  Click the icon at the upper left of the Info window to select it.

A box appears around the icon when it's selected. If no box appears when you
click, the icon can't be changed.

6.  Choose Paste from the Edit menu.

The picture you copied replaces the selected icon in the Info window. If the
picture is bigger than the icon, it automatically shrinks to fit.

7.  Click the close box to 7 close the Info window.

You can change an icon back by clicking the picture in the upper-left corner
of the Get Info box and choosing Cut or Clear from the Edit menu.

Adding labels to icons.  You can add a label to each icon, and you can easily
change the labels available for icons. (A label is different from the icon's
name; the label is visible only when the contents of a window are displayed
as a list, although the color associated with a label is visible if the
Macintosh is set to display colors or grays).

Labels provide an easy way to group related files together; for example, you
can display a list view of a window's contents by label. Or, if you have a
color monitor, you can easily identify related icons by assigning a color to
each label.

1.  Click to select the icon to which you want to add a label.



2.  Choose the label you want from the Label menu.

See also: "Changing the Contents of the Label Menu" (next section)

Changing the contents of the Label menu.  You can change the labels available
for icons in the Labels control panel. 

To change the labels available, choose Control Panels from the Apple menu and
then double-click the Labels control panel to open it.

1.  Place the pointer on the label you want to change and click to select it.

2.  Type the new label.

3.  Click the close box 3 when you've finished changing labels.

See also: "Changing the Colors in the Label Menu" later in this chapter
"Adding Labels to Icons" (previous section)

Displaying colors or shades of gray

If your Macintosh computer and its monitor can display color or multiple
shades of gray, you can designate the number of colors or shades of gray to
be displayed and then specify the colors to use in highlighting, in window
borders, in the desktop pattern, and in icons.
Specifying the number of colors or grays.  You use the Monitors control panel
to specify the number of colors or shades of gray displayed on your
Macintosh.

The number of colors (or shades of gray) your Macintosh can display depends
on the type of video capability it has. See the Special Features booklet or
other documentation that came with your Macintosh and your monitor for
details about displaying colors.

If your Macintosh offers built-in video, you can use the Monitors control
panel to assign a portion of system memory for video use. The Special
Features booklet or other documentation for your Macintosh provides
instructions for this procedure if you have a model with built-in video.

To specify the number of colors, choose Control Panels from the Apple menu
and then double-click the Monitors control panel to open it.

1.  If you have more than one monitor, click the icon of the monitor whose
colors you want to adjust.

A dark border appears around the icon to show it is selected.

2.  Click the Grays or the Colors button.

Some monitors can display only shades of gray, even if you click the Colors
button.

3.  Click the number of colors or shades of gray you want displayed on the
selected monitor (or click Black & White).

Your changes take effect immediately. The number of colors or shades of gray
you specified remains in effect until you change it.



Changing the highlight color.  You can change the color your Macintosh uses
to highlight selected text on your screen, using the Color control panel and
the color wheel dialog box. 

You can't change the highlight color if the monitor is set to display black
and white only.

To designate a highlight color, choose Control Panels from the Apple menu and
then double-click the Color control panel to open it.

1.  Open the "Highlight color" pop-up menu and choose a color or choose
Other.

If you choose a color, it appears in the Sample text box when you release the
mouse button.

If you choose Other, the color wheel dialog box is displayed.

2.  If desired, change the brightness of the color wheel by dragging the
scroll box up or down.

Scrolling up makes the color wheel brighter; scrolling down makes it darker.

3.  Place the pointer on the color wheel and click to select a new color.

The new color is displayed in the top half of the color square if your
monitor is set to display 16 or more colors. The current highlight color or
shade remains in the bottom half of the square for comparison; you can click
there to go back to it.

4.  To experiment with 4 other highlight colors or shades, drag the pointer
around the wheel or click at another point on the wheel.

If your monitor is set to display 16 or more colors, new colors or shades
appear in the upper half of the color square as you drag or click.

5.  When you are satisfied with the highlight color, click OK to confirm your
choice.

The dialog box closes, revealing the Color control panel. The new highlight
color is displayed in the "Sample text" box.

The highlight color you specified takes effect immediately and remains in
effect until you change it.

See also: "Specifying the Number of Colors or Grays" earlier in this chapter

Changing the color of windows.  You can change the color of the borders
around windows using the Color control panel.

To change the window color, choose Control Panels from the Apple menu and
then double-click the Color control panel icon to open it.

1.  Open the "Window color" pop-up menu and choose a color.

The window color changes when you release the mouse button.

2.  Click the close box to close the control panel.



Changing the colors in the desktop patern.  You can change the colors or
shades of gray displayed in the desktop pattern in the General Controls
panel.

You change colors in the pattern in one of three ways:

- Double-click a color in the color bar and choose a new color from the color
wheel dialog box. If that color currently appears in the desktop pattern
displayed in the General Controls panel, the squares change to the new color.

- Click a color in the color bar and click or drag in the editing area.

- Double-click an unused color in the color bar, change it (using the color
wheel dialog box), and click or drag in the editing area.

When you have the pattern you want, click the miniature desktop to display
it.

See also: "Changing the Pattern Displayed on the Desktop" earlier in this
chapter
"Changing the Highlight Color" earlier in this chapter

Coloring icons.  You can easily change an icon's color using the Label menu.
This menu displays labels you can use to identify icons, and it also shows
colors if your monitor is capable of displaying color or multiple shades of
gray and if you have set your monitor to display at least 16 colors or grays
in the Monitors control panel.

1.  Select the icon that you want to color.

2.  Choose the color you want from the Label menu.

The icon's color will be changed to the one selected (and the corresponding
label will be added also, when the item is displayed in a list).

The icon retains the new color until you change it.

See also: "Adding Labels to Icons" earlier in this chapter
"Specifying the Number of Colors or Grays" earlier in this chapter
"Displaying a List of Items by Name, Size, Label, Kind, or Date" in Chapter 5

Changing the colors in the Label menu.  You specify the colors available for
icons using the Labels control panel. 

To specify colors available for icons, choose Control Panels from the Apple
menu and then double-click the Labels control panel to open it.

1.  Click the color you want to change.

The color wheel dialog box opens when you click a color.

2.  Place the pointer on the color wheel and click to select a new color.

The new color is displayed in the top half of the color square if your
monitor is set to display 16 or more colors or grays. The current color
remains in the bottom half of the square for comparison.

3.  To experiment with other colors or shades, drag the pointer around the



wheel or click at another point on the wheel.

A new color is displayed in the upper half of the color square as you drag or
click.

4.  Click OK when you have selected the color you want.

The color wheel dialog box closes, showing the new color or shade of gray you
selected for that label.

5.  Close the Labels control panel.

The label color you selected remains in effect until you change it.

Configuring multiple monitors

Some Macintosh computers can use more than one monitor. If you use more than
one monitor, you need to indicate the monitors' positions and designate one
as the main monitor (the one that displays the menu bar). For additional
monitor options, see the Special Features booklet or other documentation that
came with your computer and monitor.

Indicating the positions of multiple monitors.  If you use two or more
monitors, you must indicate their relative positions so that the pointer can
move from one monitor to another. You specify monitor positions in the
Monitors control panel. 

To indicate monitor positions, choose Control Panels from the Apple menu and
then double-click the Monitors control panel to open it.

1.  If necessary, check the numbers of your monitors by pressing the Identify
button.

A large number appears in the center of each monitor's screen; it corresponds
to the number of the icon in the control panel.

2.  Drag the icon of the monitor you want to reposition to a location on the
screen that corresponds to the monitor's actual position.

The icon snaps back against another monitor icon when you release the mouse
button.

3.  Release the mouse button when the icon you're repositioning is where you
want it.

If necessary, repeat steps 1 through 3 to adjust the relative positions of
other monitors.

4.  Choose Restart from the Special menu to activate the new monitor
positions.

The monitor positions you specified remain in effect until you change them
and restart the Macintosh.

After you have specified the monitor positions, the pointer moves from one
screen to another across the border where the monitors' icons touch in the
control panel.



Selecting a monitor to display the menu bar.  You use the Monitors control
panel to designate a main monitor, the one that displays the menu bar.

Monitors of different sizes or different color capabilities:  You may want to
make your larger monitor the main monitor. If the smaller one is the main
monitor, some programs restrict the window size to the size of the smaller
monitor.

If one monitor displays color and the other doesn't, you may want to make the
color monitor the main one, to take advantage of color labels for icons and
the color capabilities of some application programs.

To designate a main monitor, choose Control Panels from the Apple menu and
then double-click the Monitors control panel to open it.

1.  If necessary, check the numbers of your monitors by clicking the Identify
button.

A large number appears in the center of each monitor's screen; it corresponds
to the number of the icon in the control panel.

2.  Drag the white menu bar from the top of one monitor icon to the icon of
the monitor you want to be your main one.

An outline of the menu bar moves with the pointer as you drag.

3.  Release the mouse button when the menu bar's outline is where you want
it.

The menu bar appears across the top of the icon for the new main monitor.

4.  Choose Restart from the Special menu to activate the new main monitor.

The monitor you specified will be the main one until you change it in the
Monitors control panel and restart the Macintosh.

Changing the screen's brightness

You can adjust the screen's brightness for viewing comfort. It's a good idea
to turn down the brightness if you're going to leave the computer on for a
while without using it. If an image is left on the screen for several hours
or more, it may damage the screen.

Or you can use a "screen saver" program, which dims the screen or displays a
moving image after a preset interval with no activity.

Adjusting screen brightness with hardware controls.  Most Macintosh models
provide a brightness dial on the monitor or the computer itself. (A few
models do not have a dial but provide software for adjusting brightness.)

1.  Locate the brightness control on your Macintosh computer or your monitor.
If your Macintosh has a separate monitor, check the monitor's manual for
specific instructions.

Most monitors that are not built in have two controls, for brightness and
contrast.

2.  Turn the control dials until the screen's appearance is satisfactory.



Adjusting screen brightness with software controls.  Some Macintosh computers
use software to control screen brightness. If your monitor does not have a
brightness control, see the Special Features booklet for your Macintosh or
the documentation that came with your computer for instructions on using the
software to adjust brightness.

Turning the Trash warning on or off

When you want to remove an item from a disk, you drag it to the Trash.  The
Trash is never emptied automatically, however. To erase the Trash's contents,
you choose the Empty Trash command from the Special menu.

To regain space on your disks, be sure to empty the Trash when it contains
files you no longer want.

To prevent you from deleting items unintentionally, a warning message appears
when you choose the Empty Trash command. 

You can turn off this warning if you wish.

Changing the Trash warning status.  You use the Info window for the Trash to
turn the warning message on or off.

1.  Click the Trash Icon select it.

2.  Choose Get Info from the File menu.

The Info window opens.

3.  Click the box at the lower-left corner of the Info window to turn the
warning on or off, then close the Info window.

Once you turn off the Trash warning message, the items in the Trash will be
erased without warning when you choose the Empty Trash command.

CHAPTER 8-EXPANDING YOUR MACINTOSH SYSTEM

The Macintosh is the heart of a powerful and versatile computer system. This
system can include such external devices as disk and tape drives, printers,
multiple monitors, scanners, modems, graphics tablets, and audio devices. All
of these devices can be connected to the computer when it is originally set
up or added later to expand its power.

The Macintosh can be expanded internally by installing additional memory and
-- in some models -- coprocessor cards, specialized video and graphics cards,
memory cache cards, and communications cards. (Cards are printed circuit
boards that fit inside the Macintosh.)

This chapter provides an overview of the procedures you follow to connect
hardware devices and install internal components in Macintosh computers.

!!  WARNING:  When you are connecting a device to your Macintosh, be sure to
follow the instructions that came with your Macintosh and with the device.
!!

Connecting hard disks, scanners, and other SCSI devices



All Macintosh computers have a socket, or port, for connecting devices that
use the Small Computer System Interface (SCSI). The SCSI port permits high-
speed communication between the computer and the device. (SCSI is commonly
pronounced "skuh-zee.")

Among the SCSI devices that are commonly used with the Macintosh are internal
and external hard disk drives, tape backup drives, CD-ROM drives, scanners,
and printers.

Because SCSI devices can be connected to one another, or daisy-chained, the
Macintosh can use up to seven of these devices, including an internal hard
disk.

Setting the SCSI ID number.  Each SCSI device that you connect to your
Macintosh needs to have a unique ID number. If two of your SCSI devices have
the same number, you need to change one of the numbers. In most instances,
you will not need to change the number unless you have two of the same kind
of device, such as two external hard disks.

The Macintosh uses the ID number to assign each SCSI device a priority. The
higher the number, the higher the device's priority. The computer itself is
number 7 and an Apple internal hard disk is number 0 (so nothing else can
have those numbers). The external devices you use most often should have the
highest priority numbers.

You change the number of an Apple SCSI device by pressing an opened paper
clip (or similar instrument) into the ID number switch on the device. Check
the manual that came with your SCSI device for more detailed instructions.

!!  WARNING:  If you have two SCSI devices with the same ID number, be sure
to change the ID number of one device. If you try to use two SCSI devices
with the same ID number, your devices may not work properly, and you could
lose information on one or both devices.  !!

Daisy-chaining SCSI devices.  SCSI devices can be linked together by cables
to form a chain. The arrangement of devices in a chain does not determine
their priority in communicating with the Macintosh; the devices' ID numbers
determine priority.

To ensure accurate transmission of information, a special connector, called a
SCSI cable terminator, must be placed at each end of a SCSI chain. 

Every Macintosh that has an internal Apple hard disk has a built-in SCSI
cable terminator. Some models have an internal terminator whether or not they
have an internal hard disk. In most cases, the computer's internal terminator
serves as the terminator for one end of the SCSI chain.

If you connect an external SCSI device to your Macintosh, you may need to
attach an additional terminator. External SCSI devices manufactured by Apple
do not have built-in cable terminators (and therefore require you to attach
one), but some devices from other manufacturers do.

If you have a Macintosh Portable, consult the Macintosh Portable Handbook for
instructions about using terminators.

You connect devices with SCSI cables. There are two kinds of SCSI cables. A
SCSI system cable connects the first device to the computer. A SCSI
peripheral cable connects one device in a chain to another.



When you connect a SCSI cable to the Macintosh, you place the cable in the
SCSI port on the computer's back panel. 

!!  IMPORTANT: Always turn on your external SCSI devices before turning on
your computer. Also be sure to turn on the first and last device in a chain
of SCSI devices. Otherwise your computer cannot recognize the SCSI devices.
!!

Connecting peripheral devices

The Macintosh has several ports to which you can connect peripheral devices.
Each port is marked by a distinctive icon on the back panel of the computer
and on the Apple cable that connects the appropriate device to it.

Connecting a printer.  You connect most printers to the Macintosh through the
printer port. This port is a serial port, meaning that it transmits the bits
that make up the computer's information in single file, or serially.

Some printers, including most LaserWriter models, are designed for use on the
AppleTalk network system. Others, such as the ImageWriter II, can operate
either as stand-alone printers for one Macintosh or as network devices.

All these printers connect to the Macintosh's printer port. LaserWriter
printers with the letters "SC" in their names connect to the SCSI port.

A printer can also be connected to the modem port, which is also a serial
port. You use the Chooser to indicate the port to which a printer is
connected.

"Choosing a Printer" in Chapter 4 
"Introduction to Using Your Macintosh on a Network," Chapter 1 of the
Macintosh Networking Reference

Connecting a modem.  The modem port on the Macintosh back panel is a serial
port similar to the printer port. You use it to connect an external modem, a
device that allows the computer to communicate with other computers over
telephone lines.

It's best to connect a modem to the modem port (although it's possible to
connect it to the printer port) because the computer gives the modem port
priority when checking for activity. This helps to ensure that the modem's
communication link remains intact.

Connecting an external floppy disk drive.  Some Macintosh computers have a
disk drive port, to which you can attach an external floppy disk drive.

If your Macintosh does not have a disk drive port, you can buy an external
floppy disk drive that attaches to the SCSI port.

Connecting a keyboard, mouse, or other pointing device.  On most Macintosh
models, you connect the mouse and the keyboard to Apple Desktop Bus (ADB)
ports. These ports allow you to use a variety of input devices with your
system, such as a graphics tablet, a specialized keyboard, a trackball, a
light pen, or a barcode reader.

You can connect ADB devices to one another and thereby connect several to
each ADB port on the computer's back panel. Most Macintosh keyboards contain



two ADB ports, and some monitors have an ADB port.

The number of input devices you can use is limited by the combined power they
require and by their performance. Usually you can connect no more than six
ADB devices -- three for each ADB port.

!!  IMPORTANT:  Do not exceed the Apple Desktop Bus power requirements when
using ADB input devices. The combined power used by all devices must not
exceed 500 milliamperes (mA). Be sure to check the power required for each
device you use and make certain that the total needed is less than 500 mA.
Consult the Special Features booklet or other documentation that came with
your Macintosh computer, and the specifications for your ADB devices, for
more information.  !!

Macintosh Plus mouse and keyboard:  The Macintosh Plus and earlier models of
the Macintosh do not have ADB ports. On these computers, the mouse connects
to a mouse port on the back panel of the computer and the keyboard plugs into
the front of the computer.

Connecting headphones or speakers.  You can attach an audio device, such as
speakers, an amplifier, or headphones, to the sound output port on the back
of the Macintosh. The sound output port accepts a standard stereo miniplug,
like that used to attach headphones to a portable stereo player.

Adding additional monitors

You can use multiple monitors simultaneously with most Macintosh computers.
To attach an additional monitor, you also need a video card or adapter.

Connecting a monitor to a built-in video port.  Some Macintosh computers
provide a built-in video port to which you can attach one monitor.

!!  IMPORTANT:  If you're connecting a monitor to the built-in video port of
your Macintosh, make certain that the computer is turned off before
connecting the monitor. If the computer is turned on while the monitor is
connected, you need to restart the computer before you can use the monitor.
!!

For complete instructions consult the booklet Setting Up Your Macintosh or
other documentation that came with your Macintosh, and the documentation for
your monitor.

Connecting a monitor to a video card.  On most models of the Macintosh, you
can connect a monitor to a video card installed in the Macintosh. The card
must be installed in the computer before you connect the monitor.

For complete instructions consult the booklet Setting Up Your Macintosh (or
other documentation for your Macintosh) and the documentation for your
monitor and video card.

Additional monitor for a Macintosh with a built-in monitor:  Some Macintosh
computers that have a built-in monitor, such as the Macintosh SE/30, can also
use an external monitor. The external monitor is connected to an adapter that
must be installed by an authorized Apple representative.

Positioning monitors.  If there is interference (an image that seems to
"shiver") when you're using two monitors, then position the monitors farther
apart or angle the backs of the monitors away from each other.



!!  WARNING:  When setting up your monitors, be sure not to cover the
ventilation openings on the monitors or on the Macintosh. Some monitors are
too large to be placed on top of the computer. Check the setup guide for your
Macintosh and the monitor's documentation for special instructions.  !!

"Indicating the Relative Positions of Multiple Monitors" in Chapter 7

Installing expansion cards in NuBus slots

Macintosh II-family computers and some other models contain slots for
installation of expansion cards. These cards exchange signals with the
computer through the NuBus interface; consequently, the cards are known as
NuBus cards, and the expansion slots are called NuBus slots. (Some models of
the Macintosh also have another type of expansion slot, discussed later in
this chapter.)

Most video cards used with monitors are NuBus cards; there are also cards
that add extra memory to your system, specialized graphics and video cards,
coprocessor cards for enhanced performance, and cards that provide
connections for specific types of computer networks.

Most Macintosh II models have either three or six NuBus slots.

!!  IMPORTANT:  If you are leaving some empty expansion slots in your
Macintosh, position the cards for maximum airflow and cooling: leave an empty
slot between cards, and if you have six slots in your Macintosh, use the slot
closest to the fan last.  !!

See the guide Setting Up Your Macintosh (or other documentation for your
Macintosh) for detailed instructions on installing expansion cards.

See also: "Ensuring Adequate Ventilation" later in this chapter

Using multiple NuBus cards

If you use two or more NuBus expansion cards in your Macintosh, you need to
observe the following precautions to assure safe operation of the computer.

Power requirements and limitations.  The combined power consumption of all
NuBus cards in your Macintosh must not exceed the limits established for that
model.

Expansion cards can draw three types of power from a NuBus slot:

- +5 volt current

- +12 volt current

- -12 volt current

Each card may draw from these currents in varying amounts. Consult the
Special Features booklet (or other documentation for your Macintosh) and the
specifications for each card that you use to determine the combined power
consumption for each type of current. Then make certain that the totals do
not exceed the recommended limits. (You can calculate the total limits by
multiplying the recommended limit per card by the number of slots in your
model.)



Recommended

Type of current                 limit per card

+5 volt                           2.0 amps

+12 volt                          0.175 amps

-12 volt                          0.100 amps

!!  WARNING:  Exceeding the power limits could damage your NuBus cards or the
computer.  !!

Ensuring adequate ventilation.  When operating, NuBus cards generate heat. If
you use several cards in your Macintosh, make certain that you position them
to allow maximum air circulation around the cards.

For example, if your Macintosh has six NuBus slots and you are using three
cards, place the cards in the second, fourth, and sixth slots (starting from
the end opposite the disk drive) to ensure maximum air circulation.

Installing cards in a special slot

Some Macintosh computers can use an expansion card that fits into a special
slot, called the memory cache slot in some models and the processor-direct
slot in other models.

!!  IMPORTANT:  If you plan to use a card in a special slot, make certain
that the card you install is designed for your Macintosh. Installing a card
designed for a different model could damage the card and the computer.  !!

The procedure for installing a card in the memory cache slot or the
processor-direct slot varies. With some models, such as the Macintosh SE/30,
an authorized service provider must install the card. Consult the Setting Up
Your Macintosh and Special Features booklets or other documentation for your
Macintosh for details.

Expanding memory on the main circuit board

The RAM in most Macintosh computers is provided in packages called Single In-
line Memory Modules (SIMMs). Each SIMM consists of a group of RAM chips on a
circuit board that has electrical contacts along one edge. This board is
plugged into a SIMM socket on the computer's main circuit board.

The RAM in your Macintosh can be expanded by adding SIMM modules to those
already installed or exchanging the existing modules for ones that contain
chips with greater storage capacity. (In some models, the system RAM can also
be expanded by installing a NuBus memory card.)

If you plan to expand the computer's memory, make certain that the chips or
SIMMs used are the correct ones for your Macintosh. Consult the Special
Features booklet or other documentation that came with your Macintosh for
information about the RAM chips and SIMMs.

!!  WARNING:  RAM expansion on the main circuit board should be done only by
an authorized Apple representative or another qualified technician.
Modification of the circuit board by anyone except a qualified technician



voids the warranty for your Macintosh and could cause damage.  !!

CHAPTER 9-MACINTOSH MAINTENANCE

Your Macintosh computer is sturdy and requires little maintenance. But like
any piece of electrical equipment, it should be handled carefully and in
accordance with its design and specifications.

This chapter provides

- some general precautions for setting up and working with the computer

- guidelines for maintaining a safe operating environment for the Macintosh

- instructions for cleaning system components

- instructions for testing and repairing disks

- information about changing the clock battery

- information about Apple service and support

Setup and general care

Follow the suggestions in this section to ensure that your Macintosh stays in
good operating condition.

All system components.  When setting up and using the Macintosh and its
components, be sure to follow these procedures:

- Handle all equipment with care and always place components on a sturdy,
flat surface.

- Carefully follow the setup instructions provided with your Macintosh and
its components.

- Always hold a cable by its connector when attaching it to or removing it
from a component. Don't force a connector into a port on the Macintosh or a
component. If you can't get the pieces to join easily, make sure the
connector matches the port. You can consult your Apple dealer or a technician
for help.

- Turn off the Macintosh and all components before adding or removing any
part of the system, and before connecting or disconnecting any cables. If you
add or remove a component or its cable while the computer is on, you may
damage the Macintosh, the component, or both.

- Be careful not to spill any food or liquid on the computer, keyboard,
mouse, or other components. If you do spill something, be sure to turn the
Macintosh off and unplug it before attempting to deal with the situation.

!!  WARNING:  Plug the power cords for the Macintosh and its components only
into three-prong, grounded outlets. The Macintosh's grounding-type plug is a
safety feature; do not defeat the purpose of this plug. Disconnect the power
plug if it becomes frayed or otherwise damaged.  !!

Monitor.  Whether your Macintosh has a built-in screen or a separate monitor,
be sure to follow these procedures:



- Turn down the brightness control on the screen if you leave the Macintosh
turned on for extended periods. If the brightness is not turned down, the
image on the screen could "burn in" and permanently damage the screen.

You can also use a "screen saver" program, which dims or varies the image on
the screen when the Macintosh has been idle for a specified period of time.
These programs are available from independent suppliers and user groups.

- If your Macintosh has a separate monitor, make sure that none of the
ventilation openings on the computer or the monitor are covered or
obstructed.

- Some large monitors, such as the Apple Two-Page Monochrome Monitor, cannot
safely be placed on top of the Macintosh. Follow positioning instructions for
the monitor.

Keyboard.  Take care not to spill any liquid or greasy or sticky substances
on the keyboard. If you spill something on the keyboard and it stops working,
follow these procedures:

- If the liquid is thin and clear, unplug the keyboard, turn it upside down
to let the liquid drain out, and dry it for 24 hours at room temperature. If
the keyboard still doesn't work, take it to your authorized Apple dealer for
repair.

- If the liquid is sweet or sticky, unplug the keyboard and take it to your
authorized Apple dealer for repair.

Floppy disks and drives.  If your Macintosh has an 800K internal or external
disk drive, be sure to place the plastic disk-shaped piece (placed in the
drive at the factory) in the disk drive whenever you transport the Macintosh
or disk drive. If your Macintosh has a SuperDrive, you don't need to use a
plastic disk.

Do not use high-density disks in 800K disk drives. These disks are meant for
use only in SuperDrive disk drives.

Chapter 6, "Managing Disks and Disk Drives"

Power supply.  The power supply in your Macintosh is a high-voltage component
and should not be opened for any reason, even when the computer is off. If
the power supply needs service, please contact your authorized Apple dealer
or service provider.

Operating environment

The Macintosh is designed to operate reliably in a suitable environment. To
maintain this environment:

- Keep the Macintosh and components out of direct sunlight and##T##free from
exposure to rain or other moisture.

- Operate the Macintosh only at temperatures between 50 degrees and either 95
or 104 degrees Fahrenheit (between 10 and 35 or 40 degrees Centigrade),
depending on the model, and at humidity between 5 and 95 percent. (See the
Special Features booklet or other documentation for your Macintosh for
details.)



- Be certain that no ventilation areas are blocked. Do not put papers, disks,
or other items on the air circulation areas of the system, even temporarily.
Preventing proper air circulation can cause components to overheat rapidly,
which can damage them or lead to unreliable operation.

- If there is interference on the monitor's screen or on a television or
radio near your Macintosh, move the affected components farther apart. If two
monitors interfere with each other, for example, separate them further.

Cleaning system components

You can clean the exterior of most Macintosh system components, the monitor
screen, and the mouse.

Computer and peripheral device cases.  To clean the case of your Macintosh or
a peripheral device:

- Use a damp, soft, lint-free cloth to clean the computer's exterior.  Avoid
getting moisture in any openings.

- Don't use aerosol sprays, solvents, or abrasives when cleaning the computer
or other components.

Monitor.  Follow this guideline when cleaning the monitor's screen:

- Put household glass cleaner on a soft cloth and wipe the screen. Don't
spray the cleaner directly on the screen, because the liquid may drip into
the monitor or computer.

Mouse.  The mouse contains a small ball that rolls as you move the mouse. You
can keep this ball free of dirt and grease by using the mouse on a clean,
lint-free surface and cleaning it occasionally.

1.  To clean the mouse, first turn off the Macintosh.

You should always turn off electrical equipment before disassembling any
part.

2.  Turn the mouse over and open the plastic ring on the bottom that holds
the ball.

There are two different types of rings used on the mouse. One is opened by
turning the ring counterclockwise, the other is opened by moving the ring
downward until it pops out.

3.  Remove the ring and the ball beneath it.

Turn the mouse over while holding one hand underneath it to catch the ring
and ball.

4.  Clean the three small rollers inside the mouse with a cotton swab
moistened with alcohol.

Rotate the rollers to clean all their surfaces.

5.  Wipe the mouse ball with a clean, soft, dry cloth.

Don't use any liquid to clean the ball.



6.  Gently blow into the mouse case to remove any dust that has collected
there, then replace the ball and ring.

Testing and repairing a disk

Both floppy disks and hard disks can become damaged from repeated use and
handling. The Macintosh system software comes with some tools for testing
disks and repairing some types of damage or wear.

If you see a message reporting that a disk is damaged or unreadable, these
tools may help to diagnose and correct the problem.

Using Disk First Aid to test or repair a disk.  You can test floppy disks and
hard disks with the Disk First Aid application, supplied with system software
(on the Disk Tools disk). Disk First Aid also repairs some types of damage to
disks.

1.  To test or repair a disk, start Disk First Aid by double-clicking its
icon.

The application opens and presents a dialog box for you to select a disk.

2.  Select the disk you want to test and repair, using the Drive and Eject
buttons as necessary. Then click Open.

The name of the disk you selected appears, and a message reports that Disk
First Aid is ready.

3.  If you want automatic repair, choose Repair Automatically from the
Options menu.

4.  Click Start to begin testing the disk.

A message at the top of the screen reports testing and repair progress and
results.

5.  When testing and repairing  are completed, choose Quit from the File
menu.

If you want to test another disk, choose Close from the File menu, then
select and open the disk and follow steps 3 and 4.

If Disk First Aid doesn't correct the disk problem, try one of the following
measures:

- Use Disk First Aid one or two more times with the disk. Occasionally
repeating this process corrects the problem.

- Use another disk repair or recovery utility. Some disk repair utilities let
you recover information from a damaged disk.

- Consult a technician or other specialist for help.

- Once you have recovered all the information you can, erase (reinitialize)
the disk. If this doesn't work, discard the damaged disk.

Using HD SC Setup to test a SCSI hard disk.  You can test a SCSI hard disk
with the Apple HD SC Setup application, supplied with the system software (on



the Disk Tools disk).

1.  Start Apple HD SC Setup by double-clicking its icon.

2.  Select the disk you want to test, using the Drive button if necessary.
Then click Test.

The disk's SCSI ID number is displayed above the Drive button; the disk's
name is displayed in the message box at the bottom of the screen.

3.  An alert box appears before testing begins, asking you to confirm or
cancel the test. Click OK to continue.

Testing begins; the spinning beach ball icon indicates that testing is under
way.

4.  When a dialog box appears telling you that testing is complete, click
Quit.

If the test indicates a problem, you may be able to correct it by using Disk
First Aid or another disk repair utility, or you may have to reinitialize the
disk. Consult a technician or other specialist for assistance if necessary.

Changing the clock battery

All Macintosh computers have a system clock that runs continuously. When the
computer is turned off, a battery maintains the time.

The clock battery on most Macintosh computers is located inside the case. If
your system clock begins to keep inaccurate time or stops when the computer
is turned off, have your authorized Apple dealer or representative replace
the battery. If your battery runs low, you may need to reselect your choice
in the control panels and in the Chooser after replacing the battery.

Clock battery on Macintosh Plus: You can change the clock battery in the
Macintosh Plus yourself. Instructions for changing the battery are provided
in the documentation for the computer.

CHAPTER 10-Troubleshooting

Occasionally you may experience a problem with your Macintosh. The
descriptions of problems, causes, and possible solutions in this chapter
should help you solve difficulties with your Macintosh's operation.

Be sure to check the Special Features booklet or other documentation that
came with your computer for additional troubleshooting information.

General tips

If your Macintosh or a component is not working properly but its problem is
not described in this chapter, you can try some general measures that may
help you solve the problem.

Take your time.  When you see an error message on the screen, you don't have
to take an action immediately. The message will stay on the screen until you
click the button or turn off the Macintosh.

To help diagnose and correct the problem, try to gather as much information



about the situation as you can:

- Make a note of exactly what you were doing when the problem occurred. Write
down the message on the screen and its ID number (if any) as well as the
programs you were using and the names of any items you know have been added
to the System Folder since the system software was installed. (It's a good
idea to keep a list of such items on a piece of paper.) This information will
help a service person diagnose the problem should you need to take the
computer to your authorized Apple dealer for repair.

- Check the screen for any clues that are visible. Is a menu title selected?
What programs and document icons are open? Note anything else that seems
relevant to the situation.

- If you were writing new text and were not able to save it before the
problem occurred, you can write down the text that's still visible on the
screen so that some of your work will be easy to replace.

- Ask other Macintosh users about the problem you're having; they may have a
solution for it.

Start over.  Often you can eliminate a problem simply by clearing the
computer's memory and starting over.

- If possible, save any open documents before restarting the Macintosh. (If
your system is frozen and does not respond to any input, or if you have a
"bomb" message on the screen, saving may not be possible. You can try
pressing Command-Option-Esc to quit the program you were using when the
problem occurred; if this works, you can then save the documents that were
open in other programs before restarting.)

- Choose Restart from the Special menu or from the dialog box, if you can. If
you can't choose Restart, turn off the Macintosh using the power switch, wait
at least 10 seconds, then turn it on again. (Occasionally when there's a
problem, the power switch doesn't turn off the computer. In that case, unplug
it.)

- If you suspect that the problem is with a peripheral device, such as a
printer or external hard disk, turn it off for 10 seconds or more, then turn
it on again and restart the Macintosh.

Make certain that all parts of the system software are from the same version
and that you have only one System Folder on your startup disk.  These tips
help keep your system software in good working order:

- Before you install a new version of system software, be sure to make a
backup copy of the version you are replacing in case you need to use it at a
later time, to run a program that is incompatible with the new version, for
example.

- If the startup disk's System Folder becomes damaged, either reinstall the
software on that disk or copy the System Folder from a good disk onto the
disk with the damaged System Folder.

- When you install a new version of system software, verify that the new
versions of drivers for the printer and other types of devices you use are in
the System Folder of your startup disks.



Make certain that your programs are in good working order.  Here are tips for
keeping your application programs working effectively:

- If you have problems with an application program, replace it with another
working copy from the original program disk.

- If a new copy of the application program doesn't correct the problems,
check with the program's manufacturer to make sure that the version of the
program you have is compatible with the version of the Macintosh system
software you are using. (You can often upgrade to a newer version of the
program free or for a modest fee.)

- Be sure to keep only one System Folder and only one version of each
application program on your hard disk. You can use the Find command to see if
there is more than one System Folder on your hard disk.

- If you use any special programs that customize your System Folder (system
extensions or control panels), check with the sources or developers of those
programs before you install them to make sure that they are compatible with
the version of Macintosh system software you're using.

Keep backup copies of your work, your programs, and your System Folder.  To
ensure that the information and the programs you use with your Macintosh will
always be available, back up your work regularly and make a backup copy of
each program when you begin using it.

- If you use a hard disk for most of your work, be sure to make copies of all
key programs and files on floppy disks.

- To protect essential information, such as business archives and financial
records, consider making duplicate backup copies on floppy disks and storing
them in another location.

Rebuild your desktop regularly.  A process known as "rebuilding the desktop"
helps your Macintosh keep track of data on your startup disks.

- To rebuild the desktop of a startup disk, hold down the Option and x keys
while starting up your computer. Keep holding down the keys until you see a
message asking whether you want to rebuild the desktop.

- Follow the rebuilding procedure for each of your startup disks once a month
or every other month.

Avoiding data loss or damage

In recent years, many computer users have experienced problems with viruses -
- malicious programs that damage files or erase disks. A virus could be
introduced into your Macintosh system from a disk you or someone else put in
a disk drive, from a network device such as a file server, or from an
electronic bulletin board service.

Check regularly for viruses.  You can use any of several virus-detection and
elimination programs to check your Macintosh disks for viruses. Such programs
are available from user groups, computer bulletin boards, and dealers.

Even if you don't notice problems with your computer's operation or with the
information on your disks, you should check for viruses frequently if you
exchange disks or information with other users.



A good anti-virus strategy includes these elements:

- Check your primary disk or disks regularly with a virus-detection program
and correct any problems it finds.

- Whenever you get a disk from anyone -- even if it's commercial software --
check it for viruses before using it or copying anything from it to your hard
disk.

- If your Macintosh is on a network or you use a modem to connect with
information services or bulletin boards, check for viruses as often as it's
practical -- ideally, each time you copy any information from an outside
source.

- If you are part of a work group that includes a number of Macintosh users,
set up a "virus-detection station" that everyone can use to check disks (and
to copy the latest version of virus-detection software if your group has a
site license for it).

- If you give information to other Macintosh users on disk or send
information electronically, make certain that there are no viruses on your
system before distributing the information.

- Since new viruses often appear, make sure you always have the latest
version of any virus-detection software.

- To avoid compatibility problems, be sure to use only one virus detection
program.

Problems getting the computer to operate

Here are some potential problems, likely causes, and suggested solutions.

The computer is turned on but the screen is dark.  Cause:  The Macintosh or
the monitor is not getting power, or the screen isn't getting light.

Try these actions:

- Check that the power cord is plugged in and firmly connected to the
computer and that the electrical socket has power.

- If you have a separate monitor, check that the monitor is turned on.

- Check the screen's brightness control and turn it up if necessary.

- If you use a screen saver program, press a key or move or click the mouse
to turn off the screen saver.

- Turn off the computer and turn it on again.

When you start up, the screen is bright but the desktop doesn't appear.
Cause:  The system software is not on the disk or the disk drive is not
operating properly.

Try these actions:

- If you see the "happy Macintosh" icon, you don't need to do anything. The
system software is being loaded.



- If you see a disk icon with a blinking question mark on it, your system is
waiting for you to insert a startup disk in the floppy disk drive. This icon
means that the computer didn't recognize your startup hard disk, there is no
system software on your hard disks, or the system software on your hard disks
has been damaged.

If this happens, use another startup disk to start up and check to see if the
hard disk icon appears on the desktop. (If not, see your dealer.)

- If you see the disk icon with an X on it, that means the computer didn't
find a System Folder on the floppy disk you inserted. Wait while the computer
checks your hard disks for a System Folder.

- If you see the "sad Macintosh" icon, there's a problem with the system
software on the disk or possibly with the computer hardware.

If a floppy disk was inserted, eject the disk by turning off the computer,
then holding down the mouse button while you turn the computer on again.
(Holding down the mouse button at startup ejects all floppy disks.) Try
starting up with a different startup disk. If the "sad Macintosh" icon
appears again, see your dealer.

The pointer doesn't move, or moves erratically, when you move the mouse.
Cause:  The mouse is not connected properly or its signals are not reaching
the computer.

Try these actions:

- Turn off the computer using the power switch, then check that the mouse
cable is connected properly at both ends.

- Clean the mouse. (See the instructions in Chapter 9.)

- Restart the Macintosh with a different startup disk. If the pointer still
doesn't move, consult your dealer.

See also: "The Pointer 'Freezes' on the Screen" later in this chapter

Typing on the keyboard produces nothing on the screen.  Causes:  No insertion
point or text is selected; the keyboard is not connected properly; or the
keyboard's signals are not reaching the computer.

Try these actions:

- Make sure the program you want to type in is the active program.

- Place the pointer in the active window and click to set an insertion point
or drag to select text (if applicable).

- Turn off the computer, then check that the keyboard cable is connected
properly at both ends.

- If the connections are secure and typing still yields no results, shut down
and turn off the Macintosh, then unplug the keyboard cable. Connect the cable
to another Apple Desktop Bus port on the computer and the keyboard. (You may
have to switch the mouse to another port also.) If typing still shows nothing
on the screen, the problem is most likely in the keyboard itself.



- Restart the Macintosh with a different startup disk. If typing still
doesn't produce text on the screen, consult your dealer.

"The Pointer 'Freezes' on the Screen" later in this chapter.

You can't save anything onto a floppy disk.  Cause:  The disk is full, the
disk is damaged or locked, or the disk drive is not working properly.

Try these actions:

- Make sure the locking tab on the back of the disk at the top left is in the
down (unlocked) position. (A hole should not be visible.) See Chapter 6 for
more information.

- If you see a message reporting that the disk is not initialized, and you
know that it has been initialized, eject the disk and carefully insert it
again. If the same message appears, the disk is probably damaged. (You may be
able to recover the information on it with Disk First Aid or a disk-recovery
program.)

- If you see a message that the disk is full, eject that disk and insert
another that has adequate space for your document, or erase unneeded files
from the disk.

- Check the disk for obvious damage to the plastic case or the sliding metal
shutter.

- Insert a different disk and try saving again. If you can't save on the
second disk, the problem may be with the disk drive.

- Before concluding that the disk drive is the problem, save your files on a
disk in a different drive, if you have one, and then restart the Macintosh.
Try saving something on a disk that you know is not damaged placed in the
suspect drive. See your dealer if saving fails again.

You can't eject a floppy disk.  Cause:  The signal to eject the disk is not
reaching the computer or the disk or drive is damaged.

Try these actions, in the order presented here:

- Hold down the x and Shift keys and press the number 1 key in the top row of
the keyboard to eject a disk in the internal drive; press Command-Shift and
the number 2 to eject a disk in an external floppy drive or the second
internal drive.

- If the preceding action doesn't work, shut down and turn off the Macintosh.
If the disk isn't ejected, then hold down the mouse button when you turn the
computer on again.

- If neither of the preceding actions works, locate the small hole to the
right of the disk drive's opening, and carefully insert the end of a large
straightened paper clip into it. Press gently until the disk is ejected, but
do not force it. (See Figure 10-2.) This method of ejecting a disk should be
used only when the other suggested methods do not work. If this method
doesn't work, take the computer or disk drive to your dealer to have the disk
removed.

You can't start up from a hard disk or can't see its icon on the desktop.



Cause:  The computer did not recognize the disk's signals or the disk drive
is not working properly.

Try these actions:

- If the hard disk drive is an external one, make sure it is turned on and
its cable is connected firmly, then restart the Macintosh.

- If the disk drive is an internal one, turn off the Macintosh, wait at least
10 seconds, then turn it on again.

- If the hard disk is your startup disk, start up with a different disk and,
if the hard disk's icon appears, reinstall the system software on the hard
disk.

- If you have more than one hard disk in your Macintosh system, check the
SCSI ID number of each external hard disk and all other SCSI devices
connected to your computer. If two devices have the same ID number or if any
external device has the ID number 7 or 0, the computer will not recognize one
of the devices. Change the number to a number not currently used. See Chapter
8 for more information.

"Testing and Repairing a Disk" in Chapter 9

A dialog box with a bomb appears.  Cause:  Your system has a software
problem.

Try these actions:

- Write down what you were doing when the message appeared, and write down
the number on the message, if there is one.

- Click the Restart button on the screen (if one is displayed as part of the
message). The computer may start up normally.

- If no Restart button is displayed (or clicking it doesn't work), use the
power switch to turn off the Macintosh, wait at least 10 seconds, then turn
it on again. The system may start up normally. (Occasionally it's necessary
to pull the plug, if the power switch doesn't turn off the computer.)

- If the Macintosh doesn't restart with the startup disk you were using when
the problem occurred, try to start up with a different startup disk.

- If the Macintosh starts up with a different disk, reinstalling the system
software may correct the problem with the first startup disk.

- Check the startup disk and program you were using when the bomb message
appeared. You may have been using elements of the system software that were
incompatible with each other or with the program you were using.

- Make sure that all programs, desk accessories, and system extensions you're
using are compatible with the system software.

- Sometimes incompatible system extensions or control panels can cause the
system to display a bomb message. Restart while holding down the Shift key;
this disables all system extensions. If startup is normal with this method,
then remove all extensions and put them back into the System Folder one at a
time,  starting up after you add each extension. This procedure should



identify any incompatible extensions.

- Try removing any other items you recently placed in the System Folder, and
then restart to see if the computer works all right.

!!  IMPORTANT:  Always be sure to use the Installer when you upgrade to a new
version of Macintosh system software, and always verify that the programs you
use are compatible with the version of system software you have installed.
!!

The pointer "freezes" on the screen.  Cause:  Your system has a software
problem.

Try these actions:

- Press Command-Option-Esc to close the program in use when the problem
occurred. If this works, you can then save the documents open in other
programs before restarting.

- Turn off the Macintosh with the power switch, wait at least 10 seconds,
then turn it on again.

- If the Macintosh doesn't restart with the same system disk, try to start up
with a different startup disk.

- If the Macintosh starts up with a different disk, check the startup disk
and program you were using when the system froze. You may have been using
elements of the system software that were incompatible with each other or
with the program you were using. Reinstalling the system software may correct
the problem.

!!  IMPORTANT:  Always be sure to use the Installer when you upgrade to a new
version of Macintosh system software, and always verify that the programs you
use are compatible with the version of system software you have installed.
!!

Printing problems

If you have a printer connected to your Macintosh, you might encounter one of
the following situations. Consult your printer manual for additional
troubleshooting suggestions.

The printer doesn't print your document.  Cause:  The Print command isn't
reaching the printer or the printer isn't working properly.

Try these actions:

- Check that the printer is turned on and warmed up (if it's a LaserWriter,
it should have printed a sample page).

- Check the cable connections to the printer.

- If your printer is an ImageWriter, make sure that the Select light is on.
(Press the Select button to turn the light on.) If this is the problem, a
dialog box on the screen may inform you that the printer is not responding.

- Check that the printer (and its name, if it's a LaserWriter) is selected in
the Chooser. See "Choosing a Printer" in Chapter 4.



- If the Chooser does not show an icon for the type of printer you want to
use, place the driver or drivers for that printer in the Extensions folder
(in the System Folder of your startup disk) and restart the Macintosh. See
Chapter 4 for more information.

You try to print and you see an error message.  Cause:  The printer has
received conflicting signals.

Try these actions:

- Make sure the printer is turned on and warmed up.

- Make sure that everyone on the network is using the same version of the
printer driver. (You can use the System 7 printer drivers with earlier
versions of system software.)

- If your printer is an ImageWriter, check that the select light is on. Press
the Select button to turn the light on, and try to print again.

- If you see an error message stating that the printer could not print your
document, turn off the printer for at least 10 seconds, then turn it on again
and wait for the printer to warm up before trying to print again.

Problems working with programs and system software

You may occasionally have a problem with programs and files such as aliases
or items you put in the Apple menu.

The Apple menu does not contain all the items it should.  Cause:  All items
have been removed from the Apple Menu Items folder, or that folder is not
inside the System Folder.

Try these actions:

- Use the Find command to locate the Apple Menu Items folder. If that folder
is not in the System Folder, put it there.

- If the Apple Menu Items folder is inside the System Folder, open it to see
if any items are inside the folder. If not, put the items you want to appear
in the Apple menu inside that folder.

You open an alias and nothing happens or you see a message reporting that the
original file isn't available.  Cause:  The alias has been damaged or the
original file has been removed.

Try these actions:

- Select the alias and choose Get Info from the File menu. Then click the
Find Original button to locate the original. (The message on the screen may
provide the information you need.)

- Locate the original file and make another alias for it, then replace the
damaged alias with the new one.

The control panel settings change unexpectedly.  Cause:  The battery needs
changing. See an authorized service provider for a new battery.



APPENDIX A

Keyboards and Character Sets

You can choose from several keyboards for use with most Macintosh computers;
the layout and selection of keys varies somewhat among the different
keyboards.

On all Macintosh keyboards you can use modifier keys, such as Option,
Command, and Shift, to type optional characters. The Key Caps desk accessory
shows the location of optional characters for each font installed in the
System file.

Keyboard layouts

The illustrations that follow show the layouts of the Macintosh Classic
keyboard and the Apple keyboards. Each of these keyboards can be used with
several Macintosh computers.

See also: "Using Special Keys and Indicators on the Keyboard" in Chapter 1
Appendix D, "Special Aids for Using the Mouse, Keyboard, and Screen"

Special characters

You can produce a variety of optional characters by pressing the Option key
or Option and Shift keys in combination with certain character and number
keys.

Viewing special characters with Key Caps.  The Key Caps desk accessory shows
you the standard and optional character sets produced when modifier keys,
such as Shift and Option, are pressed. Key Caps is supplied with the
Macintosh system software.

You open Key Caps by choosing its name from the Apple menu or by double-
clicking its icon.

The Option and Shift keys together and the Control key also produce optional
characters in some fonts. (There is no Control key on the Macintosh Plus
keyboard.)

You can display the character sets for other fonts installed in your System
file by choosing the name of the font from the Key Caps menu. 

Typing accented characters.  Using the Option key with certain other keys
lets you enter international language characters if you're using a U.S.
keyboard file. Table A-1 shows the accent marks and the key combinations that
produce them.

Table A-1    Option-key combinations for accent marks

Accent mark                      Key combination

Grave accent ( ` )               Option-`, then type the character to be
accented

Acute accent (  )                Option-e, then type the character

Circumflex (^)                   Option-i, then type the character



Tilde (~)                            Option-n, then type the character

Umlaut ( )                           Option-u, then type the character

The letter c with a                 Option-c
cedilla (ç) 

If you type an accent mark with a character that does not accept one, the
Macintosh produces the accent mark followed by the character you typed.

APPENDIX B

Using Both System 7 and an Earlier Version of Macintosh System Software

Many Macintosh users have access to more than one computer. You may sometimes
need to use an earlier version of the system software.

If you use both System 7 and an earlier version of the system software, such
as System 6, you should be aware of the following differences between the
systems.

Sharing a printer

If computers on a network share one or more printers, all computers should
use the same printer drivers. Otherwise, the printer will be reinitialized
each time someone prints a document using a different driver.

Updating printer drivers for Macintosh computers using System 7 and System 6
on a network.  If your Macintosh is on a network with computers that use both
System 7 and System 6, you should update the printer drivers for printers on
the network. The System 7 printer drivers also work with System 6.

Updating printer drivers is a simple process. Use the Installer program
provided on the Printing disk for System 7 software; this disk also contains
the System 7 printer drivers. 

You can store these files on a file server or shared disk. You don't need to
use the original disk to perform the update.

The following steps describe how to update printer drivers using the Printing
disk supplied with System 7 software.

1.  Insert the Printing disk and double-click its icon to open it.

The disk's window opens.

2.  Double-click the icon of the Installer to start the program.

The Installer's Welcome dialog box appears. It shows the icons of the printer
drivers and explains the installation options.

3.  Click OK to remove the dialog box.

The Easy Install dialog box appears. It lists the printer drivers the
Installer will update and names the disk on which the drivers will be
installed.
4.  If you want to update printer drivers on a different disk, click the



Switch Disk button until the name of the disk you want appears.

Skip this step if the disk you want is already named.

5.  If you want to add different printer drivers from the ones listed, click
the Customize button, then choose the names of the drivers you want to add.

When you click Customize, the custom installation dialog box appears, showing
a list of the printer drivers available. Shift-click to choose multiple
drivers in the list. 

Skip this step if you just want to update drivers already on your disk.

6.  Click Install when you are finished choosing drivers to update.

Updating begins. Status messages report progress.

7.  When you see a message reporting that installation was successful, click
Quit.

The Installer window closes. (If for some reason the installation was not
successful, you'll see a different message, and you can begin installation
again.)

Using the Finder

You'll notice that some items look different when you use System 7 files or
disks with a Macintosh that uses an earlier version of system software.

Extra folders on disks used with System 7.  If you use a disk with a
Macintosh that has System 7 installed and later use that disk with an earlier
version of system software, you'll notice two extra folders on the disk.
These folders are named Desktop and Trash. They may contain items that were
either on the desktop or in the Trash when the disk was used with System 7.

Desk accessories and fonts.  Desk accessories supplied with System 7 can't be
used with an earlier version of system software. These items will have
document icons; they can't be opened.

TrueType fonts can't be used with system software version 6.0.4 or earlier.

See also: "Appendix B of the Macintosh Networking Reference

APPENDIX C:

Exchanging Disks and Files With MS-DOS Computers

Many Macintosh computers have an internal Apple SuperDrive floppy disk drive.
The SuperDrive can read and initialize 3.5-inch disks for both Macintosh
computers and for computers that use the MS-DOS operating system.

You use the utility program Apple File Exchange to initialize disks in the
MS-DOS format and to convert files from MS-DOS computers for use in a
Macintosh computer.

Using Apple File Exchange for MS-DOS disks and files
Apple File Exchange is supplied on one of the disks provided with Macintosh



system software. The program and three special translator files, which
convert documents between Macintosh and MS-DOS format, are stored in the
Apple File Exchange Folder.

Initializing an MS-DOS disk in a SuperDrive.  You can initialize a high-
density disk or a normal-density disk in MS-DOS format using a SuperDrive and
Apple File Exchange.

The following steps describe how to initialize a high-density disk in MS-DOS
format:

1.  Start Apple File Exchange by double-clicking its icon.

The program's window opens. The contents of the active window are listed on
the left side and an empty list box appears on the right side.

2.  Place a blank high-density disk in the SuperDrive.

A dialog box appears, reporting that the program can't read the disk and
asking if you want to initialize it. This dialog box shows the names of
formats available in Apple File Exchange, including Macintosh and MS-DOS. 

(You can initialize a disk that is not blank by inserting it, clicking the
Drive button until its name appears in the window, and choosing Erase Disk
from the File menu.)

3.  Click MS-DOS, then click the Initialize button.

The disk is initialized in MS-DOS format. When initialization is completed, a
dialog box appears, asking you to name the disk.

4.  Type a name for the disk, then click OK.

Use a valid MS-DOS name -- up to eight characters, followed by an optional
period and up to three characters.

The dialog box closes, and the name of the disk you initialized appears above
an empty window. This disk's icon doesn't appear on your Macintosh screen
(because the Macintosh cannot recognize a disk in MS-DOS format).

5.  Choose Quit from the File menu when you are finished using Apple File
Exchange.

Initializing a normal-density disk in MS-DOS format:  You can also use Apple
File Exchange to initialize a normal-density 3.5-inch disk for MS-DOS files.
Follow the previous steps, but place a normal-density disk in the SuperDrive
and click 720K in the dialog box that asks whether you want to initialize. 

5.25-inch disks: Some Macintosh computers can use an external 5.25-inch
floppy disk drive that can read files from MS-DOS disks. An internal adapter
or expansion card is required to connect a 5.25-inch disk drive to the
Macintosh. Apple File Exchange can translate files from these disks and store
files on them.

Converting files to and from MS-DOS format.  Apple File Exchange converts
between Macintosh files and MS-DOS files. The translator program provides two
built-in methods of translation -- text and binary. You use text translation
for text files, and binary translation for other files.



In addition, Apple File Exchange can use special translator files designed to
convert files into formats that specific programs can use. One of these
special translator files is provided with Apple File Exchange: DCA-
RFT/MacWrite, which converts documents between MacWrite format for the
Macintosh and Document Content Architecture/Revisable Form Text format (used
by many word-processing programs) for MS-DOS.

Follow these steps to translate a file:

1.  Start Apple File Exchange by double-clicking its icon.

The program's window opens, listing the contents of the active window on the
left side. An empty list box appears on the right side.

2.  Use the Open, Drive, and Eject buttons to display the files you want to
translate and the disk or folder where you want to store the translated
files.

3.  Click the names of the files or folders you want to translate.

To select multiple files or folders, hold down the Shift key and click each
name. You may have to scroll to locate the names of some files or folders.

4.  Open the translation menu you want by pointing to its title and holding
down the mouse button.

If you are translating MS-DOS files into Macintosh files, open the MS-DOS to
Mac menu. This menu shows the three translators provided with Apple File
Exchange (DCA-RFT/MacWrite, text translation, and the default binary
translation) and any other translators you've added. 

5.  Make sure that the translators for the types of files you've selected
have checkmarks; if not, choose them.

An active translator has a checkmark. The default translator has a diamond
(indicating that it's always active). Choosing an active translator makes it
inactive.

6.  Compare the size of the files or folders selected for translation with
the space available on the destination disk.

The total space required appears between the lists; the space available on
the destination disk appears below its name.

If the size of the selected items is greater than the space available on the
destination disk, then deselect some of the items (by Shift-clicking them),
remove some files on the destination disk (using the Remove button), or
change to another destination disk (using the Eject button).

7.  Click the Translate button.

If Apple File Exchange finds two or more active translators -- other than
Text or Default -- capable of translating a selected file, a message asks you
to select the translator you want.

If the names of files or folders on the destination disk are the same as
those of files or folders being translated, a message asks you to rename the



file being translated.

If a translator requires you to select options before a file is translated,
it presents a dialog box in which you select the options.

8.  Respond to any dialog boxes by selecting a translator, renaming the file,
or selecting options.

The selected files or folders are translated. Messages report the status of
copying.

If Macintosh files are being translated into MS-DOS files, the names of
translated files may be shortened to conform to the naming conventions of MS-
DOS.

9.  When all translations are finished, choose Quit from the File menu.

Converting MS-DOS files on a file server: Some file servers can
simultaneously store information created by Macintosh computers and MS-DOS
computers. For example, the AppleShare PC program allows MS-DOS computers to
store and translate files on an AppleShare file server. Consult your
authorized Apple dealer or representative for more information about using a
file server and MS-DOS files.

Other file-conversion options.  Apple File Exchange provides several options
to assist you with file conversions. 

More information about Apple File Exchange options.  To see explanations of
the translators Apple File Exchange uses, choose About the Apple File
Exchange from the Apple menu. Select a translator in the list that appears,
then click the About button for information about that item. (Click Done to
return to the program's window.)

Converting Apple II files with Apple File Exchange.  Apple File Exchange
allows you to translate files to and from the ProDOS format used by Apple II
computers. Apple File Exchange converts ProDOS files to and from Macintosh
format and MS-DOS format. You can obtain translators for ProDOS and other
operating systems from your authorized Apple dealer.

APPENDIX D

Special Aids for Using the Mouse, Keyboard, and Screen

The Macintosh system software includes components designed to assist people
who have difficulty using the keyboard or the mouse or reading the screen.
One part of this software is the Easy Access control panel, which provides
alternative ways to move the pointer and use the keyboard; the other part is
the CloseView program, which magnifies the images displayed on the screen.

Keyboard and mouse assistance with Easy Access

When you install System 7, the Easy Access control panel appears along with
the other control panels inside the System Folder.

You open the Easy Access control panel by choosing Control Panels in the
Apple menu.

The Easy Access control panel provides three features -- Sticky Keys, Mouse



Keys, and Slow Keys. These features assist people who have difficulty typing
with both hands or with manipulating the mouse. They're also useful to anyone
who wants to use the keyboard with one hand or to make very fine movements of
the pointer with better control.

Turning Mouse Keys, Slow Keys, and Sticky Keys on or off and setting options.
You use the Easy Access control panel to turn Mouse Keys, Slow Keys, and
Sticky Keys on or off and to set their options. To open this control panel,
choose Control Panels from the Apple menu and then double-click the Easy
Access control panel icon.

To turn Mouse Keys on or off and set its options:

- Click a button to turn Mouse Keys on or off and to set the initial delay
and maximum speed for mouse movement. 

To turn Slow Keys on or off and set its options:

- Click a button to turn Slow Keys on or off and to set the acceptance delay
for keystrokes and the key click sound. 

To turn Sticky Keys on or off and set its options:

- Click a button to turn Sticky Keys on or off and to set the beep indicating
that a modifier key has been pressed. 

Pointer control with Mouse Keys.  Mouse Keys lets you move the pointer using
the numeric keypad on your keyboard. You can click, drag, and perform all the
usual mouse activities with the keypad, and you can gain precise control of
mouse movements when needed.

To use Mouse Keys, follow these steps:

- To turn on Mouse Keys, press Command-Shift-Clear.

- Use the numeric keypad to move the pointer and to click, drag, and make
other mouse movements.

- To turn off Mouse Keys, press Clear.

"Using Special Keys and Indicators on the Keyboard" in Chapter 1 Appendix A,
"Keyboards and Character Sets"

Using Slow Keys for keyboard control.  Slow Keys helps prevent accidental
keypresses by waiting a brief amount of time before accepting a keystroke.
You can use Slow Keys in combination with Sticky Keys if you wish.

To use Slow Keys:

- To turn on Slow Keys, press the Return key for about 8 seconds. (After 4
seconds, you will hear a short warning beep.)

- Press the keys as you normally do.

- To turn off Slow Keys, press the Return key for about 8 seconds. (After 4
seconds, you will hear a short warning beep.)

Typing keyboard commands with Sticky Keys.  Sticky Keys lets you type



combination keystrokes, consisting of a modifier key and another key, without
actually pressing the keys simultaneously. The modifier keys are the Command
key, Option key, Shift key, and Control key.

When Sticky Keys is turned on, it displays one of its three icons at the
right side of the menu bar (next to the icon for the Application menu). These
icons indicate that the feature is on, that a modifier key has been pressed,
or that a modifier key has been locked (by pressing it twice).

To use Sticky Keys:

- To turn on Sticky Keys, press the Shift key five times without moving the
mouse.

- Press the modifier key you want to use, then press the additional key or
keys that complete the command.

When you press a modifier key, the Sticky Keys icon changes to indicate that
the modifier key is set or locked.  Pressing a modifier key once sets it;
pressing the key twice locks it.

- To turn off Sticky Keys, press the Shift key five times, or press any two
modifier keys at the same time.

Magnifying the screen with CloseView

CloseView is a utility program supplied with Macintosh system software that
magnifies the image on the screen.

You install CloseView by dragging its icon to the Control Panels folder (in
the System Folder) of your startup disk, then restarting your computer. 

You turn CloseView on and select its features in the CloseView control panel.
Choose Control Panels from the Apple menu, then open the CloseView icon to
display the CloseView control panel.  Then select the options you want to
use.

To turn CloseView on or off, press Option-Command-O.

When CloseView is on, you'll see its frame (a heavy box covering a portion of
the screen). The frame moves when you move the pointer on the screen or when
you type (the frame follows the insertion point).

When the frame is displayed, you can turn magnification on with the keystroke
Option-Command-X. (The same keystroke turns magnification off.)

To increase or decrease the power of magnification, use the keystroke Option-
Command-Up Arrow (increase) or Option-Command-Down Arrow (decrease).


